# Contents

**Preface** ................................................................................................................................. 9
  - Documentation Conventions ......................................................................................... 9
  - Related Publications ................................................................................................ 10
  - Customer Support ..................................................................................................... 10
  - Information You Should Have .................................................................................... 11
  - User Feedback ............................................................................................................. 12
  - Information Builders Consulting and Training .......................................................... 12

**1. Describing and Accessing Data Overview** ................................................................. 13
  - A Note About Data Source Terminology ..................................................................... 14
  - How Applications Interpret Data .................................................................................. 14
  - Obtaining a Synonym .................................................................................................. 15
    - Reference: How an Adapter Works........................................................................... 15
  - What You Can Do With a Synonym ............................................................................. 16
  - Ways to Enhance a Synonym ....................................................................................... 16
  - How an Application Uses a Synonym ......................................................................... 17
  - Alternative Tools on the Reporting Server Console .................................................. 17

**2. Accessing Data and Creating Synonyms** ................................................................. 19
  - Configuring Adapters and Remote Servers in Developer Studio .............................. 19
    - Configuring the Application Path .............................................................................. 21
      - Procedure: How to Configure the Application Path .............................................. 22
    - Showing Only Applications in Path .......................................................................... 23
      - Procedure: How to Show Only Applications in Path .......................................... 23
    - Data Access Configuration Variations ...................................................................... 23
      - Procedure: How to Access the Create Synonym Tool .......................................... 28
      - Procedure: How to Access the Create Synonym Tool From Developer Studio Reporting Tools ............................................................... 32
  - Managing Adapter Configurations ............................................................................. 34
    - Procedure: How to Manage Adapter Configurations .............................................. 35
  - Configuring Adapters in Developer Studio.................................................................. 39
    - Procedure: How to Configure an Adapter in Developer Studio ................................ 40
  - Creating Synonyms in Developer Studio .................................................................... 46
    - Procedure: How to Create a Synonym in Developer Studio ................................... 46

Describing Data With Graphical Tools
3. Using the Synonym Editor ................................................................. 71

Synonym Editor Layout ................................................................... 72
Reference: Synonym Editor Main Attributes .................................... 72
Reference: Synonym Editor Toolbar ............................................... 74
Reference: Synonym Editor Options Settings ............................... 77
Reference: Synonym Editor Format Options Settings .................. 79
Reference: Synonym Editor Column Management Settings ........ 79
Reference: Synonym Editor Traces Options Settings ................. 84
Reference: Synonym Editor Run Options Settings ...................... 85
Reference: Synonym Editor - Segment Context Menu ................. 86
Reference: Synonym Editor - Column/Field Context Menu ......... 89
Reference: Synonym Editor - Field View Tab .......................... 92
Reference: Synonym Editor - Segment View Tab ...................... 94
Reference: Synonym Editor - List View Tab ................................. 94
Reference: Synonym Editor - Modeling View Tab ...................... 95
Reference: Synonym Editor - Text View Tab ............................. 96
Reference: Synonym Editor - Access File Text View Tab ........ 97

Viewing and Editing Synonym Attributes .................................... 97
Procedure: How to View and Edit Synonym Attributes .................... 97
Reference: File Attributes Summary ........................................ 99
Reference: Segment Attributes Summary .............................. 100
Reference: Column/Field Attribute Summary .............................. 103

Setting Up Multilingual Titles and Descriptions .......................... 106
Procedure: How to Set Up Multilingual Titles and Descriptions ........................................... 106
Enhancing Synonyms Using the Modeling View ................................................................. 110
Procedure: How to Enhance Synonyms Using the Modeling View .................................. 110
Procedure: How to Edit Synonyms Using the Modeling View ........................................... 112
Reference: Modeling View Context Menu ......................................................................... 117
Reference: Join Editor Dialog Box ....................................................................................... 119
Viewing Data Profiling Characteristics ................................................................................ 120
Data Profiling a Synonym or Segment .................................................................................. 120
  Procedure: How to View Data Profiling for a Synonym or Segment ................................. 120
Data Profiling Columns ....................................................................................................... 121
  Procedure: How to View Data Profile Statistics ............................................................... 121
  Procedure: How to View Data Profile Patterns ............................................................... 122
  Procedure: How to View Data Profile Values ................................................................. 123
  Procedure: How to View the Data Profile Values Graph ............................................... 124
  Procedure: How to View the Data Profile Values Pie Graph ......................................... 125
  Procedure: How to View Data Profile Duplicate Values ............................................... 126
  Procedure: How to View Data Profile Outliers .............................................................. 127
Creating Cluster Joins ......................................................................................................... 128
  Procedure: How to Create a Cluster Join by Enhancing Existing Synonyms ................... 129
  Procedure: How to Create a Cluster Join Using a New Synonym .................................... 135
Defining Dimensions for OLAP Analysis ........................................................................... 136
  Using the Dimension Builder in the Synonym Editor Modeling View .............................. 137
    Procedure: How to Add a Parent/Child Hierarchy ....................................................... 137
    Procedure: How to Delete a Dimension ....................................................................... 138
    Procedure: How to Add Levels to the Hierarchy ......................................................... 138
    Reference: Dimension Builder Toolbar ....................................................................... 139
Using the Synonym Editor for Cube Data Sources ............................................................. 140
  Reference: Cube View Tab Objects ................................................................................. 141
  Procedure: How to Edit Field Names and Titles ............................................................ 142
  Procedure: How to Edit Titles for Multiple Languages .................................................... 143
  Procedure: How to Delete Measures, Dimensions, or Parent/Child Hierarchies .......... 145
  Procedure: How to Create Virtual Measures With COMPUTE Fields ............................ 145
Creating Business Views .................................................................................................... 148
  Procedure: How to Create a Business View Using the Synonym Editor .......................... 149
  Procedure: How to Alternatively Create a Business View Using the Synonym Editor ..... 151
4. Analyzing Metadata and Procedures ................................................................. 197
   Analyzing Procedures With the Impact Analysis Tool ........................................... 197
   Procedure: How to View Impact Analysis Results From the Synonym Editor........ 197
   Procedure: How to Use the Impact Analysis Tool From the Interface.................. 198
   Viewing Data Profiling Characteristics .............................................................. 201
   Data Profiling a Synonym or Segment. ............................................................... 201
      Procedure: How to View Data Profiling for a Synonym or Segment................. 201
   Data Profiling a Single Column. .......................................................................... 204
      Procedure: How to View Data Profile Statistics............................................... 205
      Procedure: How to View Data Profile Patterns............................................... 206
      Procedure: How to View Data Profile Values.................................................. 206
      Procedure: How to View the Data Profile Values Graph................................... 207
      Procedure: How to View Data Profile Duplicate Values................................. 207
      Procedure: How to View Data Profile Outliers............................................... 207

5. Adding Data and Rebuilding FOCUS Data Sources ............................................. 209
   Creating a FOCUS Data Source .......................................................................... 209
      Procedure: How to Create a Data Source......................................................... 209
   Rebuilding a Data Source .................................................................................... 210
      Procedure: How to Use the Rebuild Utility....................................................... 210
      Rebuilding a Disorganized File......................................................................... 212
      Rebuilding the Index......................................................................................... 212
         Procedure: How to Index a Field After Data Is Entered............................... 212
         Procedure: How to Rebuild the Index............................................................ 212
   Checking the Integrity of a Data Source. .............................................................. 213
      Procedure: How to Check the Structural Integrity of a FOCUS Data Source........ 213

Customer Connections ......................................................................................... 219
Preface

This documentation describes how to create the metadata for the data sources that WebFOCUS projects will access. It is intended for database administrators, application developers, or other information technology professionals who will create the metadata used by WebFOCUS to access corporate data.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Describing and Accessing Data</td>
<td>Introduces data source descriptions and explains how to use them.</td>
</tr>
<tr>
<td>Overview</td>
<td></td>
</tr>
<tr>
<td>2 Accessing Data and Creating</td>
<td>Describes how to create a synonym for your data source description.</td>
</tr>
<tr>
<td>Synonyms</td>
<td></td>
</tr>
<tr>
<td>3 Using the Synonym Editor</td>
<td>Describes the Synonym Editor and how you may use it to view and edit synonyms.</td>
</tr>
<tr>
<td>4 Analyzing Metadata and</td>
<td>Describes how to analyze procedures using Impact Analysis and how to view Data Profiling for the columns in a synonym.</td>
</tr>
<tr>
<td>Procedures</td>
<td></td>
</tr>
<tr>
<td>5 Adding Data and Rebuilding</td>
<td>Describes utilities to create new FOCUS data sources and to refresh existing data sources after the structure has changed.</td>
</tr>
<tr>
<td>FOCUS Data Sources</td>
<td></td>
</tr>
</tbody>
</table>

Documentation Conventions

The following table describes the documentation conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS TYPEFACE</td>
<td>Denotes syntax that you must enter exactly as shown.</td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td>this typeface</td>
<td></td>
</tr>
<tr>
<td>Convention</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable) in syntax for a value that you or the system must supply.</td>
</tr>
<tr>
<td><strong>underscore</strong></td>
<td>Indicates a default setting.</td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select.</td>
</tr>
<tr>
<td>Key + Key</td>
<td>Indicates keys that you must press simultaneously.</td>
</tr>
<tr>
<td>{  }</td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
<tr>
<td>[  ]</td>
<td>Indicates a group of optional parameters. None are required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td></td>
<td>Separates mutually exclusive choices in syntax. Type one of them, not the symbol.</td>
</tr>
<tr>
<td>...</td>
<td>Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td>. .</td>
<td>Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
</tbody>
</table>

**Related Publications**

Visit our Technical Documentation Library at [http://documentation.informationbuilders.com](http://documentation.informationbuilders.com). You can also contact the Publications Order Department at (800) 969-4636.

**Customer Support**

Do you have any questions about this product?
Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at http://forums.informationbuilders.com/eve/forums.

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, http://www.informationbuilders.com. It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of www.informationbuilders.com also provides usage techniques, diagnostic tips, and answers to frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

**Information You Should Have**

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).
- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
  - The software release.
  - Your server version and release. You can find this information using the Version option in the Web Console.
  - The stored procedure (preferably with line numbers) or SQL statements being used in server access.
  - The Master File and Access File.
The exact nature of the problem:

- Are the results or the format incorrect? Are the text or calculations missing or misplaced?
- Provide the error message and return code, if applicable.
- Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?

What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?

Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. Please use the Reader Comments form at the end of this document to communicate your feedback to us or to suggest changes that will support improvements to our documentation. You can also contact us through our website, http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an Education Representative.
Describing and Accessing Data Overview

Developer Studio provides a set of graphical tools that you can use to describe and access many types of data sources, including:

- Relational, such as DB2, Oracle, Sybase, Informix, and JDBC.
- Multidimensional, such as SAP BW and Essbase.
- Procedural, such as Web Services and CICS Transactions.
- XML
- Hierarchical, such as IMS and FOCUS.
- Sequential, both fixed-format and free-format.
- Indexed, such as ISAM and VSAM.
- Networked, such as CA-IDMS.
- Other popular data sources, such as Lotus Notes and LDAP.

These graphical tools are designed to:

- Translate the schema of the data source into metadata that WebFOCUS can read and report against.
- Optionally, enable you to customize and enhance the generated metadata without having to know the details of the underlying WebFOCUS data description language.

In this chapter:

- A Note About Data Source Terminology
- How Applications Interpret Data
- Obtaining a Synonym
- What You Can Do With a Synonym
- Ways to Enhance a Synonym
- How an Application Uses a Synonym
- Alternative Tools on the Reporting Server Console
A Note About Data Source Terminology

Different types of data sources make use of similar concepts, but refer to them differently. For example, the smallest meaningful element of data is called a field by many hierarchical database management systems and indexed data access methods, but called a column by relational database management systems.

There are other cases in which a common concept is identified by a number of different terms. For simplicity, we have standardized on a single set of terms. For example, we usually refer to the smallest meaningful element of data as a field, regardless of the type of data source. However, when required for clarity, we use the term specific to a given data source. Each time we introduce a new standard term, we define it and compare it to equivalent terms used with different types of data sources.

How Applications Interpret Data

When your application accesses a data source, the application needs to know how to interpret the data that it finds. To accomplish this, the application reads a synonym, which is an Information Builders term for the generated metadata associated with the particular data source.

Your application needs to know:

- The overall structure of the data. For example, is the data relational, hierarchical, multidimensional, or sequential? Depending upon the structure, how is it arranged or indexed?

- The specific data elements. For example, what fields are stored in the data source, and what is the data type of each field (character, date, integer, or some other type)?

The synonym provides an alias for the data source that tells the server how tables are described and where to find them.

The primary component of a synonym is a Master File. The Master File describes the structure of a data source and its fields. For example, it includes information such as field names and data types.

For some types of data sources, an Access File supplements the Master File. An Access File includes additional information that completes the description of the data source. For example, it includes the full data source name and location. The nature of the information in the Access File is specific to each data source. You need one Master File and for some types of data sources, one Access File to describe a data source.
Obtaining a Synonym

You can generate synonyms using the Developer Studio Create Synonym tool. This enables you to explore DBMS catalogs and select the objects for which you wish to create synonyms. The tool prompts for the information it needs to create a synonym for a particular data source and stores the generated synonym on the server.

The Create Synonym tool is described in detail in *Accessing Data and Creating Synonyms* on page 19.

In order to generate a synonym, you must be authorized to use the data against which you plan to report and you must have configured an adapter to access that type of data. When you begin to create a synonym, Developer Studio opens the Select adapter to configure or Select connection to create synonym window. The option to create the synonym becomes available only after the adapter is successfully configured.

Adapters are available for many data sources. Every adapter is specifically designed for the data source that it accesses, and, as a result, is able to translate between SQL or WebFOCUS and the data management language (DML) of the data source. Adapters provide solutions to product variations, including product differences in syntax, functionality, schema, data types, catalogs, data representations, message processing, and answer set retrieval. It is the adapter that manages the synonym creation process. For related information, see *How an Adapter Works* on page 15.

The parameters required to configure over 60 supported adapters and to create synonyms for the corresponding data sources are described in detail in the *Adapter Administration for UNIX, Windows, OpenVMS, IBM i, and z/OS* manual.

Reference:  **How an Adapter Works**

The adapter manages the communication between the data interface and the data source, passing data management requests to the data source and returning either answer sets or messages to the requestor. To perform these functions, the adapter:

- Translates the request to the applicable DML.
- Attaches to the targeted data source, using standard attachment calls.
- Passes the request to the data source for processing.
- Returns results or error conditions to the client application for further processing.
What You Can Do With a Synonym

Once you have generated a synonym, you can report against the synonym using all of the Developer Studio reporting tools. In many instances, the configured adapter and the generated synonym are all you need to access your data and create reports and graphs.

However, you may wish to enhance the synonym in order to implement particular capabilities that are supported in the WebFOCUS data description language. To do this, you can use the Synonym Editor, which is a second data description tool.

When you use the Synonym Editor, there is no need to know the data description language. The graphical tool displays all viewable and editable attributes of the synonym components. If you make changes to the generated synonym, the Synonym Editor validates your entries and displays messages if they violate the underlying syntax of the data description language.

**Note:** If you are comfortable working directly with code, you can open the synonym components in a text editor. While the text editor does some error checking, we cannot guarantee that code which is altered manually will be syntactically correct. We strongly recommend that you use the text editor as a viewing tool and make your enhancements through the graphical Synonym Editor interface. For detailed information about the underlying syntax, see the *Describing Data With WebFOCUS Language* manual.

Ways to Enhance a Synonym

The following are some of the attributes you might want to add to the synonym to enhance your data access and reporting capabilities. You can:

- Create a cluster join view by linking available synonyms to create a multisegment (multitable) file for reporting.
- Apply security rules for fields and values to ensure that user access is based on Information Builders data source security (DBA) specifications.
- Add dimensions for OLAP analysis.
- Add virtual columns (DEFINE fields) and columns for aggregated values (COMPUTE fields).
- Add filters to specify data selection criteria.
- Add group definitions for data sources that support groups.
- Add meaningful titles and descriptions, including multilanguage variations.
- Change the format of fields (for example, the size of an alphanumeric field or the format of a date field).
Create business views of the metadata in order to limit the fields available to any retrieval request that references the business view and to group fields together based on their roles in an application.

Define parent and child hierarchies for cube data sources.

The Synonym Editor is described in more detail in Using the Synonym Editor on page 71.

How an Application Uses a Synonym

Synonyms are stored separately from the associated data source. Your application uses a synonym to interpret the data source in the following way:

1. It identifies, locates, and reads the Master File for the data source named in a request.
2. It locates and reads the Access File for the data source named in the request, if that type of data source requires an Access File.
3. It locates and reads the data source(s).

The data source contents are interpreted based on the information in the synonym.

Alternative Tools on the Reporting Server Console

If you prefer to work in a thin-client web environment, you can access alternative tools on the Reporting Server Console (also called the Web Console) from Developer Studio. The Reporting Server Console enables you to configure adapters, create and enhance synonyms, and perform a wide range of other server-related tasks.

Although the look and feel of the Reporting Server Console is different from the Developer Studio interface, the options on the corresponding tools are largely identical. However, a few options that are currently supported in Developer Studio are not supported on the Web Console at the present time. These include:

- Defining hierarchies for cube-based data sources, such as SAP BW and Essbase.
- Adding dimensions for OLAP analysis.
- Creating business views of your data.

Procedures for accessing the Reporting Server Console, configuring adapters and remote servers, and creating synonyms are described briefly in Accessing Data and Creating Synonyms on page 19 and extensively in the Adapter Administration for UNIX, Windows, OpenVMS, IBM i, and z/OS manual.
Alternative Tools on the Reporting Server Console
Before you can create a procedure that reports against a data source, your application must be able to access the data and understand how the data is organized. To obtain this information, your application reads a synonym which generally consists of two files:

- A Master File that describes the data for WebFOCUS reporting. This file contains field names and formats for the columns in the data source. The synonym also contains an alias for the data source.

- An Access File that contains additional information needed by WebFOCUS to access data. This information, which is required by many data sources, includes the real name and location of the data source.

Often, a synonym already exists on the server, and reporting can begin at once. However, if the synonym you need does not exist on the server, an authorized server or application administrator can create it directly from Developer Studio using the Create Synonym tool.

**In this chapter:**

- Configuring Adapters and Remote Servers in Developer Studio
- Creating Synonyms in Developer Studio
- Defining a Remote Server in the WebFOCUS Client Communication File

### Configuring Adapters and Remote Servers in Developer Studio

This chapter focuses primarily on the WebFOCUS Environments, Data Servers area of the Developer Studio Explorer, where you can access data and develop applications directly on a remote WebFOCUS Reporting Server using Developer Studio tools. The chapter describes the graphical tools that enable you to access data and create metadata, as well as several configuration variations that affect your selection and use of these tools.

Project-area options for data access and development are described in the *Developer Studio Application Development Getting Started* manual. Note that the procedures for accessing data and creating synonyms for use in the Projects and Managed Reporting environments are similar to those described in this chapter for WebFOCUS Environments.
The image below displays the WebFOCUS Environments, Data Servers area of the Developer Studio Object Explorer.

The Data Servers area displays each WebFOCUS Reporting Server that the WebFOCUS Client can access and permits development against multiple Reporting Servers, which may be configured on any supported platform.

The Data Servers folder is always accessible from the Developer Studio Object Explorer. The folder lists the applications you have access to and the resources (files) stored in these applications.

The default WebFOCUS Reporting Server (named EDASERVE) is created during installation and displayed in the Data Servers area.
In the previous image, notice that several remote servers have been added. An Applications folder beneath each WebFOCUS Reporting Server displays the directories based on the Application Root directory (APPROOT) for that WebFOCUS Reporting Server (on Windows, drive:\ibi\apps by default). For this example, a server called FLATIRON (UNIX Dev WF Reporting Server) is shown with its Applications folder expanded. Any directory located under APPROOT appears under the Data Servers Applications folder. In addition, you can map an application that is not under APPROOT (but resides elsewhere in the file system) to be accessible as a virtual application. The mapped application is displayed for use, along with the applications that are physically under APPROOT.

The Data Servers area gives you access to the file resources on all WebFOCUS Reporting Servers in your environment. You can create and manage metadata, procedures, HTML files, and WebFOCUS StyleSheets. You can also perform operations on GIF images and other files, such as FOCUS data sources. For organizational purposes, these application files are displayed in virtual folders labeled HTML Files, Maintain Files, Master Files, Other, and Procedures.

The virtual folders appear this way by default. However, if you wish, you can hide the virtual folders from the Object Explorer toolbar.

If you are developing applications using a remote WebFOCUS Environment, you must first set up your environment to be able to create synonyms (Master and Access Files) and access the associated data on a remote WebFOCUS Reporting Server. For details on how, when, and where to create this metadata, see Data Access Configuration Variations on page 23.

**Configuring the Application Path**

While working in the WebFOCUS Environments area of Developer Studio, you can configure the Application Path for a Reporting Server if you have the required user privileges.
**Procedure: How to Configure the Application Path**

1. Select the Reporting Server you want to configure from the Data Servers area.
2. Right-click the **Applications** folder and select **Configure Application Path**.
   The Application Path dialog box appears as shown in the following image.

3. Select the **In Path** check box for the Configuration Path you want to set.
   The following options are available in the Application Path dialog box.
   - You can change the Application Path search order by using the arrows to move the selected application up or down.
   - The Preview button displays the syntax of the Application Path statement that will be created.
   - The Test button performs a test against the Application Path and provides file statistics.

4. Click **Save** to exit and save changes.
   If APPLOCK is set on the server, the option to configure the Application Path will not be available. In this case, you will only see applications that you are allowed to access. Other commands, such as New Application, Create, Delete, Rename will be disabled.
Showing Only Applications in Path

By default, Developer Studio displays all applications available for the Reporting Servers based on Reporting Servers APPROOT directory configuration.

Procedure: How to Show Only Applications in Path

You can select to view applications that are only in the Reporting Servers Application Path by selecting a server under the Data Servers area.

1. Select the Reporting Server you want to configure from the Data Servers area.
2. Right-click the Applications folder and select Show Applications in Path to see all available applications, as shown in the following image.

If APPLOCK is set on the server, the options to control how applications are displayed are not available. In this case, you will only see applications that you are allowed to access. Other commands, such as New Application, Create, Delete, and Rename will be disabled.

Data Access Configuration Variations

If you are working on the platforms served by Developer Studio (UNIX, Windows, OpenVMS, IBM i, and z/OS), you can use the Developer Studio Create Synonym tool to set up access to your data. This process involves configuring adapters, adding remote servers if necessary, and then creating the required synonyms.
Tip: Authorized administrators who prefer to work in a thin-client environment can complete these tasks from the Reporting Server Console, which is accessible from the Developer Studio Object Explorer toolbar. Both approaches edit the same underlying server files, so it does not matter which you use. For more information, see Using the Reporting Server Console for Data Access and Synonym Preparation on page 61.

Configuring adapters. An adapter enables an application to access a data source. Each type of data source requires its own adapter to properly convert data or application requests into native statements and return optimized answer sets to the requesting program.

For example, if you wish to report against data in an Oracle database, you need to configure the Adapter for Oracle, which enables you to create the synonyms you need to access and read your Oracle data. To access Microsoft SQL Server data, you need to configure the Adapter for Microsoft SQL Server, and so on. An adapter must be configured on each Reporting Server that accesses the corresponding type of data.

For details, see Configuring Adapters and Remote Servers in Developer Studio on page 19.
Adding remote servers to your server configuration (if needed).

In order to understand when this step is required, it is useful to start by understanding when it is not required. If you have configured adapters and your data is directly accessible from your default WebFOCUS Reporting Server, as represented in the image below, a remote server has no role in your configuration.

With this setup, once adapters are available on the default WebFOCUS Reporting Server, you can create the required synonyms. (The same is true if you are working in the Projects area from a stand-alone Developer Studio installation, where a default Reporting Server is automatically available on your local machine.)

Remote servers are required in the following situations:

At many sites, some of the data that applications need to access resides on other servers, often referred to as remote servers. The following are typical configurations.

- For the most frequently used remote server setup, sites require that each remote server be available as a distinct, named server (for example, FLATIRON and HERMES as previously shown in Object Explorer illustrations), which is visible in and accessible from the Data Servers area. This permits application development and administration, and metadata management directly against the individual remote Reporting Servers.
This modular server configuration provides great flexibility for in-place development on various types of application resources using Developer Studio tools. For example, if a self-service application resides on the FLATIRON UNIX server, you may want to edit some of its components (maybe a procedure or an HTML file) directly on that server or you may want to take advantage of the Developer Studio graphical tools to work with application files on a Mainframe server, such as PDS_SRV1 or USS_SRV2.

In this situation, you must add the servers to your default Reporting Server configuration, but you must also specify the same servers in your WebFOCUS Client configuration because that is what adds the distinct server names to the Data Servers folder. Only then can you perform operations directly on those servers. This includes creating synonyms and using Developer Studio tools to work with application files (synonyms, procedures, HTML files, and so on), organized by application under each remote server.

To expedite the client-side remote server configuration, you can access the WebFOCUS Administration Console directly from Developer Studio. For details about adding servers to the WebFOCUS Client configuration, see How to Add a Remote Server to the Environment on page 63.
Keep in mind, however, that in order to use the data on each of these remote servers, the appropriate adapters and synonyms must exist on those servers. Sometimes they are already available there, but if not, you must configure the adapters and generate the synonyms, as described later in this chapter.

In another common remote server implementation, some of the data that applications need to access resides on other servers, which are accessible through the default WebFOCUS Reporting Server. In this case, you must add each remote server to your default Reporting Server configuration before you can create synonyms that point to tables on the remote servers and report against the combined data (which can be different types and platforms).

This assumes, however, that the required synonyms already exist on the remote servers. If this is not the case, you must first create synonyms for the data accessed by the remote servers, which may, in turn, require configuring the adapter needed to create those synonyms.

Once your default Reporting Server (for example, EDASERVE) can communicate with the remote servers and access the data stored there, you can use Developer Studio tools to work with various types of application resources (Master Files, procedures, HTML files, and so on), organized for your convenience in virtual folders under each application.
It is important to note that in this setup the remote servers do not appear in the Data Servers folder. Since they can only be accessed through the default Reporting Server, they are not exposed as separate servers in Developer Studio.

Creating synonyms for use by your applications in any supported environment. The synonyms you create are stored in your Reporting Server repository, as defined by APPROOT.

For each data source the server will access, you must create a synonym that describes the structure of the data source and the server mapping of its data types. The synonyms define unique names (or aliases) for each table, view, or other type of object that is accessible from the server.

Synonyms are useful because they hide the underlying location and identity of the data source from client applications. They also provide support for extended metadata features of the server, such as virtual fields and additional security mechanisms. Using synonyms allows an object to be moved or renamed while allowing client applications to continue functioning without modification. The only modification required is a redefinition of the synonym on the server. The result of creating a synonym is a Master File and usually, a corresponding Access File, which represent the server metadata.

Appropriate synonyms must be available on the server where the data resides.

For details, see Creating Synonyms in Developer Studio on page 46.

Procedure: How to Access the Create Synonym Tool

To launch the Create Synonym tool from the WebFOCUS Environments area of the Explorer:

1. Expand your WebFOCUS Environment.
2. Expand Data Servers.
3. Expand the server.
4. Expand the Applications folder.
5. Expand an application, and right-click the Master Files folder for the application in which you wish to access the data source.

If you wish to use the data source in multiple applications or have not yet created your application, you can use the baseapp application, where resources can be stored for sharing and access by other applications.

Tip: If you are developing from the Projects area of the Explorer, expand the project, and right-click the Master Files folder, and then proceed as described.
6. Select New and then Synonym, as shown in the following image.
The Create Synonym tool opens. By default, no adapters are available. Your first task is to configure an adapter in order to be able to access a relational, multidimensional, or other type of data source.

**Note:** If any adapters have already been configured for the server, they will be listed under the Configured folder.
7. In this instance, we are assuming that no adapters are available. Expand the Available folder icon, select the required adapter, and click Configure, as shown in the image below.

![Adapter Configuration Window](image)

Depending upon your needs, you can use this window to start configuring an adapter, adding a remote server, or both.

- **Configured.** This folder contains any data adapters or remote servers that are already configured. By default, when Developer Studio is installed on its own, the Configured folder displays a Remote Servers folder that contains EDASERVE, the default WebFOCUS Reporting Server, plus any other remote Servers that may be configured with your environment.

  You can use the Configured folder to create synonyms.

  **Note:** To add a new connection, right-click your server name in the Data Servers area and select Manage Adapters.

- **Available.** This folder lists the data adapters that you can configure on the WebFOCUS Reporting Server platform.
Procedure: How to Access the Create Synonym Tool From Developer Studio Reporting Tools

When building a report, you can access the Create Synonym Tool directly from any of the Developer Studio reporting tools when you want to report against a synonym that is not available in the list.

1. There are two ways to launch the Create Synonym tool from Developer Studio reporting tools:
   - Click Create New from the Open dialog box, as shown in the image below.
Click *Create New* from the WebFOCUS Table List dialog box, as shown in the image below.

![WebFOCUS Table List](image)

**Note:** When accessing a Developer Studio Tool in the Managed Reporting Developer Edition, the Create New button will not appear for developers without Data Server privileges. The Data Server privilege is optional for Developers and standard for Content Managers and Managed Reporting Administrators. This restriction does not apply to the full edition of Developer Studio.
The Create Synonym Tool opens, as shown in the following image.

2. Continue using the tool as described in this chapter. For more information, see Configuring Adapters and Remote Servers in Developer Studio on page 19.

When you have completed the synonym creation process, the new synonym appears in the list of available synonyms. You can then select it and continue to create your report request.

Managing Adapter Configurations

While working from the WebFOCUS Environments, Data Servers area, or from the Projects area, you can manage adapters by performing the following task.
Procedure: How to Manage Adapter Configurations

1. Expand your WebFOCUS environment, right-click EDASERVE, and select Manage Adapters. For the Projects area, select the root folder Projects on, then right-click and select Manage Adapters.
The Manage and Configure Adapters dialog box opens, as shown in the following image.
2. Select the adapter you want to configure, as shown in the following image.

3. Click **Configure**.

   The Adapter Configuration dialog box appears, as shown in the following image.
An MS SQL Server adapter is issued for this configuration example.

This dialog box enables you to define connection parameters for the adapter, including Connection Name, Server, Security, profile, and Default Database.

4. Click **Configure**.

A dialog box displays, informing you that the adapter was successfully added to the configuration.
From the Manage and Configure Adapters dialog box you can also manage existing adapter connections, change properties, add connections, test connections, delete connections, and create synonyms.

### Configuring Adapters in Developer Studio

If your machine has access to your data sources, you can configure adapters to access data directly. However, some adapters may require you to configure your environment before adding them. To determine if this is required for an adapter you wish to configure, see the *Adapter Administration for UNIX, Windows, OpenVMS, IBM i, and z/OS* manual.

When you configure an adapter, information is added to the edasprof.prf and edaserve.cfg server files.
**Procedure: How to Configure an Adapter in Developer Studio**

1. From the Projects area, right-click on the root folder Projects on and select Manage Adapters.
   
   The Manage and Configure Adapters dialog box opens.

2. Expand the Available folder icons to choose from the list of available adapters.

3. Select an adapter to configure.

4. Click **Configure** to add the selected adapter.

5. Complete the connection information for your adapter.

6. Click **Configure**.
   
   A message from the Reporting Server confirms that the adapter has been added to your configuration.

7. Click **Cancel** to exit the tool.

8. Or select **Create Synonym** to proceed and create synonyms for the configured adapter.
   
   The following options are available from the Manage and Configure Adapters dialog box.
   
   - Create Synonym
   - Test
   - Delete
   - Properties

9. Click **Test** to test the connection.
   
   If you entered the correct connection parameters, sample data should appear.

   If the test fails, click the connection, select **Properties**, and adjust your information accordingly.

10. When sample data appears, click **Close**.

**Procedure: How to Add a Remote Server in Developer Studio**

From the Projects area, right-click the root folder Projects On and select Manage Adapters.

1. Expand the **Configured** folder in the Manage and Configure Adapters window of the Create Synonym tool.
The Remote Server Configuration dialog box opens, containing fields to define the connection, as shown in the following image.

3. Complete the fields as follows.

<table>
<thead>
<tr>
<th>Basic Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE</td>
<td>Type a name by which you will refer to the server. The name is your choice, but cannot be the same as any other server. It must begin with a letter and cannot be more than eight characters.</td>
</tr>
<tr>
<td>HOST</td>
<td>Specify the host name or IP address for the server.</td>
</tr>
<tr>
<td>PORT</td>
<td>Specify the base TCP port for the server. The default is normally 8120, not 8100.</td>
</tr>
</tbody>
</table>
### Basic Parameters

<table>
<thead>
<tr>
<th>Basic Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP_PORTS</td>
<td>Specify the HTTP port for the server. This is normally one number higher than the base TCP port. The default is normally 8121, not 8101.</td>
</tr>
<tr>
<td>SECURITY</td>
<td>Specify how a user should log on to the remote server:</td>
</tr>
<tr>
<td></td>
<td>- <strong>IWA (Integrated Windows Authentication, Windows only).</strong> Passes your Windows user ID and password to the server when a connection is made.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Explicit.</strong> Passes the user ID and password you provide.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Password Passthru.</strong> The user ID and password received from the client application are passed to your data source at connection time. This option requires that the server be started with security off.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Trusted.</strong> For a trusted connection, where the current logged on user ID is passed to the server.</td>
</tr>
<tr>
<td>user</td>
<td>If security is set to Explicit, type a specific user ID.</td>
</tr>
<tr>
<td>password</td>
<td>If you entered a user, provide a password.</td>
</tr>
<tr>
<td>domain</td>
<td>For a server on Windows, you can specify the domain where the user ID is defined.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>Optionally, type a description for the node. This description displays in the WebFOCUS front-end tools.</td>
</tr>
</tbody>
</table>
4. When connecting to a Unified Server, click the Advanced tab and specify the SERVICE NAME, and other parameters, as required.

<table>
<thead>
<tr>
<th><strong>Advanced Parameters</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
| **SERVICE NAME**        | CLIENT (servicename)  
Defines how to send outbound communications to a remote server.  
Servicename is optional. If servicename is provided, it must match the value of SERVICE in the service block of the server. |
| **HTTP_SSL**            | Defines whether the Secure Sockets Layer protocol is used in the Web Console listener of the remote server. Type:  
- 0 if no SSL is used in the connection to the Web Console.  
- 1 if SSL is used in the connection to the Web Console. |
| **COMPRESSION**         | Activates data compression in a data transfer between the client and server. Type:  
- 0 for no compression.  
- 1 for compression on. |
| **ENCRYPTION**          | Defines the encryption. Type:  
- 0 for no encryption.  
- DES for 56-bit fixed-key Data Encryption Standard.  
- Advanced, enables you to easily select and combine ciphers, modes, and RSA key lengths. This option provides the following ciphers: 3DES, AES 128, AES192, AES 256, and the following modes: ECB and CBC.  
- IBCRYPT for a user-defined algorithm. Key is 512-bit RSA-encrypted. |

**Note:** Encryption is not supported for the PIPE protocol. Only 0 and DES are supported for the HTTP protocol.
<table>
<thead>
<tr>
<th>Advanced Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONNECT_LIMIT</td>
<td>Defines the maximum time, in seconds, that the client will wait for a TCP connection response from the server. Enter:</td>
</tr>
<tr>
<td></td>
<td>-1 for an indefinite wait.</td>
</tr>
<tr>
<td></td>
<td>0 for no wait.</td>
</tr>
<tr>
<td>MAXWAIT</td>
<td>Defines the time, in seconds, that the client will wait for a response from the server:</td>
</tr>
<tr>
<td></td>
<td>-1 indicates indefinite timeout.</td>
</tr>
</tbody>
</table>

5. Click Save when you have provided your parameter values.  
A message indicates that a new server was added.

6. Click Cancel to exit tool or Create Synonym to continue and create synonyms for the new remote server.

7. When you open the Manage and Configure Adapters dialog box, the following options appear when you select a configured remote server: Create Synonym, Test, Delete, and Properties.

8. Click Test to test the connection.  
If the remote server is running and you typed the correct connection parameters, sample data should appear.

9. Click Close.  
If the test fails, click the server, choose Properties, and provide an explicit user ID and password. Then click Save and try the test again.

10. Click Close.

**Your next step depends on your objectives and your server configuration:**

- If you wish to make the new remote server visible in and accessible from the Data Servers folder as a distinct named entity, your next step is adding the remote server to your WebFOCUS Client configuration. The listing of servers in this location is controlled by the WebFOCUS Client and implemented through the WebFOCUS Administration Console. Proceed to *Defining a Remote Server in the WebFOCUS Client Communication File* on page 62.
If your objective is to access data on the remote server through your default server, you must determine if the appropriate adapter and required synonyms already exist on the remote server. If they do not exist, you must configure and create them. See Configuring Adapters in Developer Studio on page 39 and then Creating Synonyms in Developer Studio on page 46.

Creating Synonyms in Developer Studio

The point at which you begin to create synonyms will depend on your adapter, Reporting Server, and possibly your WebFOCUS Client configuration (as described in Data Access Configuration Variations on page 23). Whenever you are ready, you can use the Create Synonym tool to create synonyms for the data sources you need to access.

Procedure: How to Create a Synonym in Developer Studio

If it is not already open, launch the Create Synonym tool from the WebFOCUS Environments area of the Explorer:

1. Expand your WebFOCUS environment (for example, localhost).
2. Expand Data Servers.
3. Expand the server.
4. Expand the Applications folder.
5. Expand an application, and right-click the Master Files folder for the application in which you wish to access the data source.

If you wish to use the data source in multiple applications or have not yet created your application, you can use the baseapp application, where resources can be stored for sharing and access by other applications.

Tip: If you are developing from the Projects area of the Explorer, expand the project, and right-click the Master Files folder, then proceed as described.

6. Select New and then Synonym. The Create Synonym tool opens.
7. In the first window, you can choose any configured Data Adapter or Remote Server that has been added to the default Reporting Server. Note that when you are creating a synonym through a Remote Server, the remote server should already contain the required synonyms and the corresponding adapters.

![Screenshot of the first window for selecting a server or adapter.](image)

The server configuration, indicated by the server profile, determines which adapters and servers appear. In this example, the Adapter for Microsoft SQL Server is configured. If you have configured remote servers, they will appear expanded in the Remote Server folder.

8. Select the server or adapter that you configured and click OK.

A window opens in which you can enter additional information about the data source you wish to access.

**Note:** The options in this window vary depending on the type of adapter or server you are using. To access the pertinent information for your adapter directly from Developer Studio, choose **Reporting Server Console** from the Command menu. The Server Console opens. Click **Help** on the menu bar, select **Contents and Search**, expand the **Adapters** topic in the Table of Contents pane, and look for the adapter for which you wish to create the synonym. The relevant synonym creation parameters are fully defined.
The following example is for accessing an adapter for EDASERVE.

After you complete this window, the data source or server is queried to determine the metadata you can use to create synonyms. For a relational database, this is usually a list of tables or views. This window lets you filter the results so there are fewer tables from which to choose. Optionally, choose whether both Tables and Views should be returned. By default, both check boxes are selected.

For some data sources, you can select to generate synonyms for other object types, for example, Stored Procedures. If you do, the remaining input parameters will vary slightly.

9. For some data sources, you have the option to choose a database or other parameter.

You will have to select an appropriate database or choose Default Database. You will be able to choose from the database tables when this window is complete.

10. Optionally, check Filter by owner/schema and object name to filter the results based on owners or table prefixes. This limits the list of tables returned from the remote data source and makes it easier to choose the data for which you want to create synonyms. If you do not include selection criteria, the entire list of tables is displayed.

11. Click Next.
The top of the Create Synonym window now displays additional fields you can use to refine your synonym. Remember that the parameters vary depending on the type of adapter or server you are using.

The bottom of the Create Synonym window provides a list of tables for which you can create synonyms. To choose all tables, select the Default synonym name check box.
12. Click Create Synonym.

The synonym is created and a confirmation window appears. Once again, note that the window may vary depending on the type of adapter or server you are using.

The synonyms are created in the selected application directory. In this example, the default application, baseapp, is used.

13. Click Close.

Reference: Synonym Creation Parameters for Microsoft SQL Server

The following table describes the synonym creation parameters for Microsoft SQL Server, based on Tables, Views, or External SQL Scripts.

<table>
<thead>
<tr>
<th>Parameter/Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict object type to</td>
<td>Restricts candidates for synonym creation based on the selected object types: Tables, Views, External SQL Scripts, and any other supported objects.</td>
</tr>
<tr>
<td></td>
<td>Selecting <em>External SQL Scripts</em> from the drop-down list enables you to represent SQL SELECT statements as synonyms for read-only reporting. A Synonym candidate can be any file that contains only one valid SQL Query and does not contain end-of-statement delimiters (&quot;;&quot; or &quot;/&quot;) and comments. For related information, see Location of <em>External SQL Scripts</em> in this chart.</td>
</tr>
<tr>
<td></td>
<td>Depending on the adapter, you can further restrict your search by choosing check boxes for listed objects.</td>
</tr>
<tr>
<td>Parameter/Task</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Database selection</td>
<td>To specify a database from which you can select a table or other object, do one of the following:</td>
</tr>
<tr>
<td></td>
<td>✗ Check <em>Default database</em> to use the database that has been set as the default database.</td>
</tr>
<tr>
<td></td>
<td>✗ Select a database from the Select Database drop-down list, which lists all databases in the current DBMS instance.</td>
</tr>
<tr>
<td></td>
<td>Uncheck <em>Default database</em> if you are going to select a database other than the default (This does not apply to Informix SE, for which <em>Default database</em> must be checked.)</td>
</tr>
<tr>
<td>Filter by owner/schema and object name</td>
<td>Selecting this option adds the owner/schema and object name parameters to the screen.</td>
</tr>
<tr>
<td></td>
<td>✗ <strong>Owner/Schema.</strong> Type a string for filtering the selection, inserting the wildcard character (%) as needed at the beginning and/or end of the string. For example, enter:</td>
</tr>
<tr>
<td></td>
<td>✗ ABC% to select tables or views whose owner/schema begin with the letters ABC.</td>
</tr>
<tr>
<td></td>
<td>✗ %ABC to select tables or views whose owner/schema end with the letters ABC.</td>
</tr>
<tr>
<td></td>
<td>✗ %ABC% to select tables or views whose owner/schema contain the letters ABC at the beginning, middle, or end.</td>
</tr>
<tr>
<td></td>
<td>✗ <strong>Object name.</strong> Type a string for filtering the procedure names, inserting the wildcard character (%) as needed at the beginning and/or end of the string. For example, enter:</td>
</tr>
<tr>
<td></td>
<td>✗ ABC% to select all procedures whose names begin with the letters ABC.</td>
</tr>
<tr>
<td></td>
<td>✗ %ABC to select all procedures whose names end with the letters ABC.</td>
</tr>
<tr>
<td></td>
<td>✗ %ABC% to select all procedures whose names contain the letters ABC at the beginning, middle, or end.</td>
</tr>
<tr>
<td><strong>Parameter/Task</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location of External SQL Scripts</td>
<td>If you specify <em>External SQL Scripts</em> in the <em>Restrict object type to</em> field, these additional fields are displayed.</td>
</tr>
<tr>
<td>Extension</td>
<td>The following standard naming conventions apply for UNIX, IBM i IFS, and z/OS HFS:</td>
</tr>
<tr>
<td></td>
<td>- In the <em>Base Location</em> field, specify the physical directory location of the file that contains the SQL Query.</td>
</tr>
<tr>
<td></td>
<td>- In the <em>Document Extension</em> field, enter the extension of the script files to filter the list of candidates.</td>
</tr>
<tr>
<td></td>
<td>On IBM i, you can use alternative IFS naming conventions to access library members. The following entry illustrates this method:</td>
</tr>
<tr>
<td></td>
<td>- In the <em>Location of External SQL Scripts</em> field, enter:</td>
</tr>
<tr>
<td></td>
<td>/QSYS.LIB/MLIBRARY.LIB/MYSRC.FILE</td>
</tr>
<tr>
<td></td>
<td>- The <em>Extension</em> is understood to be MBR. You can enter this value explicitly or leave the input box blank.</td>
</tr>
<tr>
<td></td>
<td>During synonym generation, the adapter issues native API calls to obtain a list of elements in the select list and builds the Master File with a field for each element. The generated Access File references the location of the SQL script in the DATASET attribute, which contains the full path, including the file name and extension to the file containing the SQL Query. For example,</td>
</tr>
<tr>
<td></td>
<td>DATASET=/ul/home2/apps/report3.sql</td>
</tr>
<tr>
<td></td>
<td>When a WebFOCUS report is created, the SQL Query is used to access data.</td>
</tr>
<tr>
<td>Select Application</td>
<td>Select an application directory. The default value is baseapp.</td>
</tr>
<tr>
<td><strong>Parameter/Task</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cardinality</td>
<td>Select the <em>Cardinality</em> check box to reflect the current cardinality (number of rows or tuples) in the table during metadata creation. Cardinality is used for equi-joins. The order of retrieval is based on the size (cardinality) of the table. Smaller tables are read first.</td>
</tr>
<tr>
<td></td>
<td>If the cardinality of the tables to be used in the application are dynamic, it may not be beneficial to choose this setting.</td>
</tr>
<tr>
<td>With foreign keys</td>
<td>Select the <em>With foreign keys</em> check box to include within this synonym every table related to the current table by a foreign key. The resulting multitable synonym describes all of the foreign key relationships for the table.</td>
</tr>
<tr>
<td>Dynamic columns</td>
<td>To specify that the Master File created for the synonym should not contain column information, select the <em>Dynamic columns</em> check box.</td>
</tr>
<tr>
<td></td>
<td>If this option is selected, column data is retrieved dynamically from the data source at the time of the request.</td>
</tr>
<tr>
<td>Prefix/Suffix</td>
<td>If you have tables with identical table names, assign a prefix or a suffix to distinguish them. For example, if you have identically named human resources and payroll tables, assign the prefix HR to distinguish the synonyms for the human resources tables. Note that the resulting synonym name cannot exceed 64 characters.</td>
</tr>
<tr>
<td></td>
<td>If all tables and views have unique names, leave prefix and suffix fields blank.</td>
</tr>
<tr>
<td>Customize data type mappings</td>
<td>To change the data type mappings from their default settings, select this check box. The customizable mappings are displayed.</td>
</tr>
<tr>
<td>Overwrite existing synonyms</td>
<td>To specify that this synonym should overwrite any earlier synonym with the same fully qualified name, select the <em>Overwrite existing synonyms</em> check box.</td>
</tr>
</tbody>
</table>
**Parameter/Task** | **Description**
--- | ---
Default synonym name | This column displays the name that will be assigned to each synonym. To assign a different name, replace the displayed value.
Select tables | Select tables for which you wish to create synonyms:
- To select all tables in the list, select the check box to the left of the *Default synonym name* column heading.
- To select specific tables, select the corresponding check boxes.

**Reference:** **Synonym Creation Parameters for Stored Procedures**

For data sources that support stored procedures, you can use a reporting tool to execute a procedure and report against its output parameters and answer set. Among the benefits of this method of executing a stored procedure are:

- The retrieval of output parameters (OUT parameters, and INOUT parameters in OUT mode), as well as the answer set. Other methods of invocation retrieve only the answer set.
- The ease with which you can process, format, and display output parameters and the answer set, using TABLE and other reporting tools.

The first step is to create a synonym for the stored procedure you wish to report against. A synonym describes the parameters and answer set for the stored procedure.

An answer set structure may vary depending on the input parameter values that are provided when the procedure is executed. Therefore, you need to generate a separate synonym for each set of input parameter values that will be provided when the procedure is executed at run time. For example, if users can execute the stored procedure using three different sets of input parameter values, you need to generate three synonyms, one for each set of values. Unless noted otherwise, input parameters refers to IN parameters and to INOUT parameters in IN mode.

**Note:** If you know the internal logic of the procedure, and are certain which range of input parameter values will generate each answer set structure returned by the procedure, you can create one synonym for each answer set structure. For each synonym, simply provide a representative set of the input parameter values necessary to return that answer set structure.
A synonym includes the following segments:

- **INPUT**, which describes any IN parameters and INOUT parameters in IN mode.
  - If there are no IN parameters or INOUT parameters in IN mode, the segment describes a single dummy field.

- **OUTPUT**, which describes any OUT parameters and INOUT parameters in OUT mode.
  - If there are no OUT parameters or INOUT parameters in OUT mode, the segment is omitted.

- **ANSWERSETn**, one for each answer set.
  - If there is no answer set, the segment is omitted.
The following chart describes the parameters used to create the synonym.

<table>
<thead>
<tr>
<th><strong>Parameter/Task</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict object type to</td>
<td>Select Stored Procedures.</td>
</tr>
</tbody>
</table>
| Filter by owner/schema and object name (for DB2, this applies to all platforms except IBM i) | Selecting this option adds the owner/schema and object name parameters to the screen.  
- **Owner/Schema.** Type a string for filtering the selection, inserting the wildcard character (%) as needed at the beginning and/or end of the string. For example, enter:  
  - ABC% to select tables or views whose owner/schema begin with the letters ABC.  
  - %ABC to select tables or views whose owner/schema end with the letters ABC.  
  - %ABC% to select tables or views whose owner/schema contain the letters ABC at the beginning, middle, or end.  
- **Object name.** Type a string for filtering the procedure names, inserting the wildcard character (%) as needed at the beginning and/or end of the string. For example, enter:  
  - ABC% to select all procedures whose names begin with the letters ABC.  
  - %ABC to select all procedures whose names end with the letters ABC.  
  - %ABC% to select all procedures whose names contain the letters ABC at the beginning, middle, or end. |
### Parameter/Task | Description
--- | ---
Library | To avoid the return of an extremely large and potentially unmanageable list, always supply a value for Library or Object Name:
- **Library.** Type a string for filtering the Library (or DB2 Collection), inserting the wildcard character (%) as needed at the beginning and/or end of the string. For example, enter:
  - ABC% to select tables or views whose owner IDs begin with the letters ABC.
  - %ABC to select tables or views whose owner IDs end with the letters ABC.
  - %ABC% to select tables or views whose owner IDs contain the letters ABC at the beginning, middle, or end.
- **Object name.** Type a string for filtering the table, view, or object names, inserting the wildcard character (%) as needed at the beginning and/or end of the string. For example, enter:
  - ABC% to select all tables, views, or objects whose names begin with the letters ABC.
  - %ABC to select all whose names end with the letters ABC.
  - %ABC% to select all whose names contain the letters ABC at the beginning, middle, or end.
Object Name (IBM i only) | Select an application directory. The default value is baseapp.
Select | Select a procedure. You can only select one procedure at a time since each procedure will require unique input in the Values box on the next synonym creation pane.
Name | The name of the synonym, which defaults to the stored procedure name.
Select Application | Select an application directory. The default value is baseapp.
<table>
<thead>
<tr>
<th>Parameter/Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix/Suffix</td>
<td>If you have stored procedures with identical names, assign a prefix or a suffix to distinguish their corresponding synonyms. Note that the resulting synonym name cannot exceed 64 characters. If all procedures have unique names, leave the prefix and suffix fields blank.</td>
</tr>
<tr>
<td>Overwrite existing synonyms</td>
<td>To specify that this synonym should overwrite any earlier synonym with the same fully qualified name, select the Overwrite existing synonyms check box.</td>
</tr>
<tr>
<td>Customize data type mappings</td>
<td>To change the data type mappings from their default settings, select this check box. The customizable mappings are displayed. For information about them, see Data Type Support in the chapter for your adapter in the Adapter Administration for UNIX, Windows, OpenVMS, IBM i, and z/OS manual.</td>
</tr>
</tbody>
</table>
**Parameter/Task** | **Description**
--- | ---
Values | Select the check box for every parameter displayed for the specified procedure.

Note the following before you enter parameter values. If the procedure you selected has input parameters (IN parameters and/or INOUT parameters in IN mode), you will be prompted to enter values for them. However, the need for an explicit Value entry depends on the logic of the procedure and the data structures it produces. Therefore, while you must check the parameter box, you may not need to enter a value. Follow these guidelines:

- Explicit input values (and separate synonyms) are required when input parameter values cause answer sets with different data structures, which vary depending on the input parameters provided.

- Explicit input values are not required when you know the internal logic of the procedure, and are certain that it always produces the same data structure. In this situation, only one synonym needs to be created and you can leave the Value input blank for synonym creation purposes.

If a Value is required, enter it without quotation marks ("."). Any date, date-time, and timestamp parameters must have values entered in an ISO format. Specify the same input parameters that will be provided when the procedure is executed at run time if it is a procedure that requires explicit values.
**Example:** Synonym for Microsoft SQL Server Stored Procedure CustOrders

The following synonym describes a Microsoft SQL Server stored procedure with one input parameter, one output parameter, and one answer set containing four variables.

The Master File for the synonym is:

```plaintext
FILENAME=CUSTORDERS, SUFFIX=SQLMSS, $
SEGMENT=INPUT, SECTYPE=S0, $
    FIELDDATE=@CUSTOMERID, ALIAS=P0001, USAGE=A5, ACTUAL=A5, $
    MISSING=ON, ACCESS_PROPERTY=(NEED_VALUE), $
    SEGMENT=OUTPUT, SECTYPE=S0, PARENT=INPUT, $
    FIELDDATE=@RETURN_VALUE, ALIAS=P0000, USAGE=I11, ACTUAL=I4, $
    SEGMENT=ANSWERSET1, SECTYPE=S0, PARENT=INPUT, $
    FIELDDATE=ORDERID, ALIAS=OrderID, USAGE=I11, ACTUAL=I4, $
    FIELDDATE=ORDERDATE, ALIAS=OrderDate, USAGE=HYYMDs, ACTUAL=HYYMDs, $
    MISSING=ON, $
    FIELDDATE=REQUIREDDATE, ALIAS=RequiredDate, USAGE=HYYMDs, $
    ACTUAL=HYYMDs, MISSING=ON, $
    FIELDDATE=SHIPPEDDATE, ALIAS=ShippedDate, USAGE=HYYMDs, $
    ACTUAL=HYYMDs, MISSING=ON, $
```

The Access File for the synonym is:

```plaintext
SEGNAME=INPUT, CONNECTION=ITarget, STPNAME=Northwind.dbo.CustOrders, $
SEGNAME=OUTPUT, STPRESORDER=0, $
SEGNAME=ANSWERSET1, STPRESORDER=1, $
```

**Procedure:** How to Refresh Synonyms

Refreshing a synonym enables you to update field information while preserving the original synonym title, description, usage, virtual field, and DBA information. The action also synchronizes the Master File with the table on which the synonym is based.

You can refresh synonyms from either the Data Servers area under the WebFOCUS Environments folder or from the Projects area.

1. Right-click a synonym (Master File).
   - In the WebFOCUS Environments folder, Master Files are listed within an application in the Data Servers Applications area.
   - In the Projects area, Master Files are listed in a Master Files folder under a project name.

2. Select Refresh Synonym to recreate the Master File.
Note: Refresh is not applicable to Cube data sources at the current time, and not supported for FOCUS files.

Procedure: How to Delete Synonyms
Master Files and Access Files are removed from the server when you delete a synonym.

1. Right-click the synonym you want to delete and select Delete.
   You are prompted to confirm the deletion.

2. Click Yes to delete or No to cancel.

Using the Reporting Server Console for Data Access and Synonym Preparation
A server administrator or an application administrator who has been granted these privileges can configure and manage WebFOCUS Reporting Servers through the Reporting Server Console. You can use the Server Console as an alternative to the Developer Studio tools to configure adapters, add remote servers, and create synonyms. In addition, many other configuration options are available through the Server Console. For a full understanding of configuration options and server capabilities, see the Server Console Help system or the following manuals: Server Administration for UNIX, Windows, OpenVMS, IBM i, and z/OS and Adapter Administration for UNIX, Windows, OpenVMS, IBM i, and z/OS.

Note:
- This console is sometimes referred to as the Web Console or the Reporting Server Console.
- For Developer Studio installations that allow stand-alone development, the local, default WebFOCUS Reporting Server normally runs with security OFF, and the user who installed Developer Studio is the default administrator.

Procedure: How to Access the Reporting Server Web Console
To open the Reporting Server Console in Developer Studio:
1. Click the Reporting Server Console icon from the Object Explorer toolbar or open the following page in a web browser:

   http://hostname:port#/webconsole

   The Server Console opens in your web browser.

2. To access the Server Console help, click Help and select Contents and Search. Expand the Adapters folder in the Table of Contents, and review the information for your adapter.

---

**Defining a Remote Server in the WebFOCUS Client Communication File**

If you have configured a WebFOCUS Reporting Server elsewhere in your enterprise to access your data, and you wish to make that remote server visible in and accessible from the WebFOCUS Environments, Data Servers folder as a *distinct, named entity*, you must add the remote server to your WebFOCUS Client configuration. Except for the default server (for example, EDASERVE), which is visible under Data Servers, the listing of servers in this location is controlled by the WebFOCUS Client and implemented through the WebFOCUS Administration Console, which updates the WebFOCUS Client communication file (odin.cfg).
Once you add the remote server to your WebFOCUS Environment, you can access data and perform development directly against the named remote server. That is, you can use a variety of Developer Studio tools to access your application files, in their respective virtual folders, for development purposes. For example, you can open synonyms in the Synonym Editor, procedures in Report Painter, and HTML files in HTML Composer, and edit those files as if you were working on your local machine. These Reporting Servers can also be used by Managing Reporting if that environment is deployed in your organization.

**Procedure: How to Open the WebFOCUS Administration Console From Developer Studio**

1. Select the WebFOCUS Environment you are working with.
2. Click the WebFOCUS Administration Console icon on the Object Explorer toolbar.
3. When the Administration Console opens, log on to WebFOCUS.
   Proceed as described in *How to Add a Remote Server to the Environment* on page 63.

**Procedure: How to Add a Remote Server to the Environment**

1. Click Reporting Servers and then Remote Services.
2. Click New.
3. In the NODE field, specify the name by which you will refer to the server.
   The name cannot be the same as any other node name. It must begin with a letter and cannot be more than eight characters. When the Client accesses this server, it will use this name.
4. Specify the Node class.
   Class options are:
   - *Client*. The node will function as a stand-alone server. It can also be used as an alternate server within a cluster configuration.
   - *Cluster*. This is the primary node that will be used to distribute workload to alternate servers.
   - *CLM Processing*. The Cluster Manager node monitors server performance statistics and sends the request to the best available server for processing.
5. Click Next.
   - If you selected Client in step 4, proceed to step 6.
If you selected Cluster in step 4, proceed to step 7.

If you selected CLM Processing in step 4, proceed to step 8.

6. The New Client Node window opens. Enter the following required parameters:

   a. **CLASS.** If this is a z/OS server, you must include a qualifier.

   b. **HOST.** Host name or IP address of the server.

   c. **PORT.** Port number for the TCP listener. The default port is 8120.

   d. **HTTP_PORT.** Port number for the HTTP listener. This is normally the second consecutive port that the server uses. Type the same port number that was specified during installation. The default HTTP port is 8121.

   e. **SECURITY.** Determines how WebFOCUS connects to the Reporting Server. The following are possible SECURITY values:

      - **Default.** Is the initial value for new nodes and represents the traditional behavior, where the odin.cfg file does not contain a SECURITY keyword. In this case, WebFOCUS makes an explicit connection to the Reporting Server with whatever user ID and password it has available for the request.

      - **HTTP Basic.** Configures WebFOCUS to extract the user ID and password from the Authorization header. These credentials are then used to make an explicit connection to the Reporting Server. You should only select this option when your web tier is performing Basic Authentication.

      To verify that the Authorization header is available to WebFOCUS, expand the Diagnostics node in the Administrative Console and select HTTP Request Info.

      - **Kerberos.** Configures WebFOCUS to pass the Kerberos ticket for the user to the Reporting Server. This option enables an end-to-end Single Sign-On solution from the desktop to WebFOCUS, from WebFOCUS to the Reporting Server, and from the Reporting Server to supported relational DBMS systems. When using this option, the Reporting Server must run in security OPSYS mode. Kerberos must be specified in odin.cfg.

      - **SAP Ticket.** Enables customers using Open Portal Services in SAP Enterprise Portal to achieve Single Sign-On through WebFOCUS to a Reporting Server configured with the Data Adapter for SAP. WebFOCUS passes along the MYSAPSSO cookie of the user, created on SAP Enterprise Portal, to the Reporting Server which validates it using the SAP security API.
**Service Account.** Allows you to specify a user ID and password to be used for all connections to the Reporting Server, as shown in the following image.

![Service Account](image)

The service account credentials are encrypted and stored in the SECURITY keyword of the odin.cfg file. When defined, the service account overrides any other credentials that may be presented to WebFOCUS for this Reporting Server node, and all users connect to the Reporting Server using the same credentials. This approach does not make it possible to identify which user is running a given request on the server in Managed Reporting deployments, and therefore is not recommended for them.

**Trusted.** Allows you to connect to the Reporting Server with only a user ID. This option is useful when no password is available for the user, and controls can be placed on the server to ensure that connections from unauthorized clients are rejected (for example, employing the server RESTRICT_TO_IP setting or configuring a network firewall so that only a particular client can connect to the server).

**Note:** To complete the configuration of a trusted connection, you must enable the Reporting Server to accept trusted connections. Step 10 instructs you how to configure the Reporting Server once you have completed configuring the WebFOCUS Client.

When you select Trusted, the Pass WebFOCUS User ID and their Groups and Advanced options become available, as shown in the following image.

![Trusted](image)
If you select Advanced, you can enter the script variable and web server HTTP variable settings for User ID and the User’s Groups.

You can also specify the following optional parameters:

- **Security Object.** For any security option, an administrator can specify one or more HTTP header names and/or cookie names as follows:
  
  - **COOKIE.** Specify each HTTP cookie name separated by a comma (,). For example:
    
    cookie_name1, cookie_name2
  
  - **HEADER.** Specify each HTTP header name separated by a comma (,). For example:
    
    header_name1, header_name2

  **Note:** HTTP cookie and header names must not contain commas (,) or colons (:), since these are reserved delimiters.

REMOTE_USER is not a valid value in the HEADER input box, since it is a special type of HTTP header variable and its contents will not be sent to the Reporting Server. Instead, specify the WF_REMOTE_USER variable.

- **HTTP_SSL.** Enables encrypted communication between the Client and the Reporting Server HTTP listener. This option must be selected, if the HTTP listener of the server is configured to use SSL.

  If you are using a self-signed certificate to enable HTTPS communication with a Reporting Server, the certificate must be configured in the Java environment in which the Client is installed. This enables HTTPS communication between the Reporting Server and the following Client tools:

  - Administration Console.
  - Developer Studio Metadata tools, such as the Synonym Editor and Create Synonym tool.

- **COMPRESSION.** Turns on data compression. Codes are: 0 (off) and 1 (on).

- **ENCRYPTION.** Sets data encryption ability and the cryptography symmetric method used.

  Select one of the following options from the drop-down list:

  - 0 = off
- AES = Advanced Encryption Standard. The AES selections are in the format

\[ CIPHER \,(x) \,-\, MODE \]

where:

\[ CIPHER \]
Is AES128, AES192, AES256.

\[ x \]
Is optional and defines an RSA key length of 1024 bits.

\[ MODE \]
Is optional and is either Electronic Code Book (ECB) or Cipher Block Chaining (CBC).

For example, AES256x-CBC is the AES cipher, with 1024-bit RSA keys, and CBC mode. If the RSA or mode is not specified, then the default values are used. The RSA default value is 512 bits. The mode default value is ECB.

- IBCRYPT = user defined IBCRYPT DLL is loaded.

- CONNECT_LIM. Number of seconds the client holds the pending connection. This is useful in a cluster deployment to avoid a lengthy delay of failover response. Other possible values are 0 (no wait) and -1 (infinite wait). -1 is the default value.

- MAXWAIT. <query wait>[,.<row wait>]. Time the client waits before timeout. The first number is the return time for any row. The second number (optional) is the return time for rows beyond the first row. Time is in seconds.

- DESCRIPTION. Description for the Reporting Server node. This description displays in the front-end tools.

Because you specified Client in step 4, proceed to step 8 (and skip step 7, which is used when Cluster is specified).

7. The New Cluster Node window opens. Enter the following required parameters:
   a. ALTERNATE. Select the servers to be included in the cluster.
   b. DESCRIPTION. Description for the cluster.

8. The New CLM Processing Node window opens. Enter the following required parameters:
   a. HOST. The IP address of the Reporting Server where the Cluster Manager is configured.
b. **PORT.** UDP Port number.

c. **DESCRIPTION.** Optional description for the CLM Processing node.

You can add multiple CLM hosts and ports by clicking **Add.** A check box is added next to each new host and port combination. To remove a host and port, select the associated check box and click **Remove.**

**Note:** The node name provided in the Administration Console for CLM configurations must match the Cluster name of the Cluster Manager Server.

9. Click **Save.**

10. If you set the Client Node Security to Trusted in step 6, you must also configure the Reporting Server to accept trusted connections. On the Reporting Server, set `trust_ext` to `Y`, as shown in the following image.

   ![Access Control Settings](image)

To access the user ID in a report request, use the protected server variable `&FOCSECUSER`, which contains the connecting user ID except when Reporting Server security is OFF. `&FOCSECUSER` is recommended over previous approaches, such as the `GETUSER` and `CNCTUSR` subroutines.
Note:

- Controls should be placed on the server to ensure that connections from unauthorized clients are rejected (for example, employing the server RESTRICT_TO_IP setting or configuring a network firewall so that only a particular client can connect to the server).

- Trusted connections are not supported by servers running in security DBMS mode, or by servers on Windows running with OPSYS security. All other security modes on Windows and other platforms can accept trusted connections.

Tip: More advanced cluster functionality can be configured using the Reporting Server Web Console. For details, see Technical Memo 4665: Distributing Workload Across Clustered WebFOCUS Reporting Servers.

**Procedure:** How to Change a Remote Server Node

1. Select *Reporting Servers*, then *Remote Services*.
2. Select the node you want to change.
3. Click one of the following buttons:

   - **Modify.** Displays the settings for the selected node, enabling you to make changes. You can also click Save As to save these settings for another specified node that will be added to the `ibi\WebFOCUS\client\wfc\etc\odin.cgf` file.

   - **Remove.** Deletes the selected node. You will receive a message asking for you to confirm the deletion. This button only appears if you have more than one node defined.

   - **Profile.** Enables you to override default settings for a specific Reporting Server node. These settings are written to `ibi\WebFOCUS\client\wfc\etc\node.prf`, where node is the node you selected in step 2.

   - **Server Console.** Displays the Reporting Server Console, which enables you to remotely manage your server environment. For more information, see the *Server Administration for UNIX, Windows, OpenVMS, IBM i, and z/OS* manual.

   - **Set as Default Server Node.** This check box specifies that the node is the default Reporting Server. The node will be written as the IBI_REPORT_SERVER parameter value in the cgivars.wfs file. Note that even if you check Set as Default Server Node, this can be overridden if an IBIC_server is set in site.wfs or a node profile.
If the site.wfs file or request URL contains an IBIC_server setting, it will override the IBI_REPORT_SERVER parameter. In this case, the Administration Console indicates that the IBI_REPORT_SERVER is the default node, although it is no longer the default.

**Note:** You can select the *Sort alphabetically* check box to sort a list of multiple servers.
A synonym consists of a set of attributes that describe a data source. It provides the metadata for a data source, which enables an adapter to access and interpret the corresponding data. The Synonym Editor provides a graphical interface that enables you to work with synonyms and perform tasks, such as create, view, and modify.

**In this chapter:**

- Synonym Editor Layout
- Viewing and Editing Synonym Attributes
- Setting Up Multilingual Titles and Descriptions
- Enhancing Synonyms Using the Modeling View
- Viewing Data Profiling Characteristics
- Creating Cluster Joins
- Defining Dimensions for OLAP Analysis
- Using the Synonym Editor for Cube Data Sources
- Creating Business Views
- Adding Virtual Columns (DEFINE) in a Synonym
- Creating Filters in a Synonym
- Adding Computed Fields (COMPUTE) in a Synonym
- Storing the Number of Repetitions of a Repeating Field in a Virtual Field
- Defining Attributes and Creating Expressions for Custom Fields
- Adding Group Fields in a Synonym
- Applying Database Administrator Security
Synonym Editor Layout

The Synonym Editor is available from Developer Studio. It provides the following tabs that enable you to view and manage synonyms: Field View, Segment View, List View, Modeling View, Text View, and Access File Text View.

Reference: Synonym Editor Main Attributes

The Field View tab and Segment View tab show a hierarchy of segments and columns on the left with the attributes and values of the selected item in the Properties window, which displays by default on the right side of the tool.

Note: The attributes available depend on the type of synonym.

The Properties pane and the other available panes (Business View, Dimension Builder, or DBA) can be resized, positioned in different areas, or hidden by the available toolbar icons.

The following image is an example of an SQL data source with a key column selected.

![Image of SQL data source with selected field](image)

Information about the selected attribute is displayed at the bottom of the Properties pane. In this case, an explanation of the FIELDNAME attribute appears.
The following objects may appear in the tabs.

<table>
<thead>
<tr>
<th>Object</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Synonym Icon]</td>
<td>Synonym.</td>
<td>General icon used to indicate synonyms, visible on the left of the Field View tab. Provides information about the file name used and the application in which it resides.</td>
</tr>
<tr>
<td>![Segment Icon]</td>
<td>Segment.</td>
<td>Indicates a segment in a synonym. The root or parent segment appears first in the tree.</td>
</tr>
<tr>
<td>![Unique Segment Icon]</td>
<td>Unique Segment (FOCUS/FDS and XFOCUS only).</td>
<td>Indicates a unique segment in a FOCUS/FDS or XFOCUS synonym.</td>
</tr>
<tr>
<td>![Virtual Segment Icon]</td>
<td>Virtual Segment (Cross-Referenced).</td>
<td>Indicates a virtual or cross-referenced segment. The icon is dimmed. This type of segment is applicable to FOCUS data sources.</td>
</tr>
<tr>
<td>![Key Column Icon]</td>
<td>Key Column.</td>
<td>Indicates a key column.</td>
</tr>
<tr>
<td>![Column Icon]</td>
<td>Column.</td>
<td>Indicates a general column.</td>
</tr>
<tr>
<td>![Virtual Column Icon]</td>
<td>Virtual Column (DEFINE).</td>
<td>Indicates a virtual or defined column. For more information about virtual columns, see <em>Adding Virtual Columns (DEFINE) in a Synonym</em> on page 157.</td>
</tr>
<tr>
<td>![Index Column Icon]</td>
<td>Index Column.</td>
<td>Indicates that the native DBMS has an index for quick retrieval of values for this field.</td>
</tr>
<tr>
<td>![Filter Icon]</td>
<td>Filter.</td>
<td>Indicates a Master File filter.</td>
</tr>
<tr>
<td>![Compute Field Icon]</td>
<td>Compute Field.</td>
<td>Indicates a computed field.</td>
</tr>
<tr>
<td>Object</td>
<td>Name</td>
<td>Function</td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| ![Group Icon](image) | Group. | Indicates a group.  
This option is enabled when you select *Options* from the Tools menu. In the Options dialog box, click the check box for *Support extended options*. |
| ![Sort Object Icon](image) | Sort Object. | Indicates a sort object.  
This option is enabled when you select *Options* from the Tools menu. In the Options dialog box, click the check box for *Support extended options*. |
| ![Style Icon](image) | Style. | Indicates a style object.  
This option is enabled when you select *Options* from the Tools menu. In the Options dialog box, click the check box for *Support extended options*. |

**Reference: Synonym Editor Toolbar**

The Synonym Editor toolbar contains buttons that provide quick access to commonly performed functions. The behavior of the button is determined by the selected object. Therefore, certain toolbar buttons may be inactive.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Icon" /></td>
<td>Saves the edits made to the synonym.</td>
</tr>
<tr>
<td><img src="image" alt="Save As Icon" /></td>
<td>Saves the edits made to the synonym to a new file (Save As).</td>
</tr>
<tr>
<td><img src="image" alt="Print Icon" /></td>
<td>Enables you to print the current view.</td>
</tr>
<tr>
<td><img src="image" alt="Reference Icon" /></td>
<td>References segment from an existing synonym.</td>
</tr>
<tr>
<td><img src="image" alt="Add Icon" /></td>
<td>Enables you to add segments from an existing synonym.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Enables you to add segments through the Segment via Metadata Import option using the Create Synonym tool. This tool creates a synonym and includes it as a segment in the synonym from which the tool was launched.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Enables you to manually add segments, assigning values to segment attribute fields in the Synonym Editor. Use this approach only if you are coding a new Master File, as you would for a FOCUS data source.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Adds a column field.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Adds a virtual column (DEFINE) field. For more information about virtual columns, see Adding Virtual Columns (DEFINE) in a Synonym on page 157.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Adds a Master File filter. For more information about filters, see Creating Filters in a Synonym on page 161.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Adds a COMPUTE field. For more information about computed fields, see Adding Computed Fields (COMPUTE) in a Synonym on page 165.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Adds a group. For more information about groups, see Adding Group Fields in a Synonym on page 180.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Inserts a variable in the segment.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Deletes the selected item.</td>
</tr>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Enables you to view and refresh sample data for the object.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| ![Button](image1.png) | Enables you to add DBA security to a Master File.  
For more information about DBA security, see [Applying Database Administrator Security](#) on page 186. |
| ![Button](image2.png) | Enables a parent and child hierarchy in Dimension Builder. |
| ![Button](image3.png) | Enables you to create a Business View and a custom Master File that can use selected fields from the original synonym.  
In addition, you can customize field names, titles, and descriptions.  
For more information about Business Views, see [Creating Business Views](#) on page 148. |
| ![Button](image4.png) | Creates a default tree structure in the Business View and Dimension Builder panes based on existing segments and fields in the Master File. |
| ![Button](image5.png) | Describes the attribute properties. |
| ![Button](image6.png) | Enables you to undo or redo your actions. |
| ![Button](image7.png) | Provides a window with a compressed view of the synonym.  
Only available from the Modeling View tab. |
Reference: Synonym Editor Options Settings

When you click Tools from the menu bar and select Options, the Options dialog box appears, as shown in the following image. It enables you to set preferences and customize the look of Synonym Editor.

The Synonym Editor settings page has the following fields and options:

**Use application directory name with synonym**

If this check box is selected, an application directory name is used when you select a synonym name for both referencing an existing synonym and a transformation with db_lookup.

**Undo/Redo Limit**

Specifies the maximum number of undo/redo operations allowed in the Synonym Editor.
Support extended options

If this check box is selected, both the Sort objects and Styles folders appear when you edit a synonym.

Automatically detect new segment relations

When you create a new synonym in the modeling view of the Synonym Editor with the Automatically detect new segment relations option selected and select or drag tables into the work area (modeling view). The relationships (joins) will automatically be created for you based on the foreign key information in the access file.

Automatically arrange segments/folders in Modeling View

If you select or drag multiple or individual tables while in Modeling View, they will be automatically arranged for you.

Show parent segments in Join Editor

If this check box is selected, it controls whether or not columns in parent segments are displayed in the Join Editor for a cluster join or a synonym that references or includes, other synonyms.

Default Join Type

Sets the default Join type.

- **One-to-Many.** This join indicates a multiple instance (one-to-many) type of join. At run time, each host record can have many matching records in the cross-referenced file. Join All is the default option.

- **One-to-One.** This join indicates a single instance (one-to-one) type of join. At run time, each host record has, at most, one matching record in the cross-referenced file.

Modeling View Line Colors list box

Allows you to set colors for connector lines in the modeling view.

- **Default.** Changes the color lines in the modeling view.

- **Highlighted.** Changes the color of the highlighted lines in the modeling view.

- **No keys.** Changes the color of lines with no keys in the modeling view.

Reset Colors

Restores the default colors.
Reference: Synonym Editor Format Options Settings

The Format pane is available from the Options dialog box. To open the Options dialog box, select Options from the Tools menu. Expand the General node, and select Format, as shown in the following image.

![Options dialog box with Format pane](image)

The Fonts section has the following fields and options.

**Category**

Allows you to set the font for text in the process flow workspace, reports, text views, and log views.

**Font**

Launches a dialog box for specifying font settings.

**Reset font to defaults**

Restores the default fonts.

Reference: Synonym Editor Column Management Settings

Column Management user preferences enable you to choose which columns to display on the grids for transformations, column selection, joins, and sorts. You can also set the column display order. The settings apply to all column-related dialog boxes.
The Column Management pane is available from the Options dialog box. To open the Options dialog box, select Options from the Tools menu. Expand the General node, and select Column Management, as shown in the following image.

![Options dialog box with Column Management pane]

The Column Management pane has the following fields and options:

**Customize column display**

Lists the column-related dialog boxes that can be customized. Expanding a folder will display check boxes that can be used to add columns to each dialog box.

**Reset to default**

Restores the default values.
**Column Name Display Strategy**

Controls the information that appears in trees and grids. The available options are Name, Title, Description, and Alias. If no Title, Description, or Alias exists, the display will default to the Name.

**Note:** It is recommended that you use Title when working with Business Views.

Expand any of the available Customize column display options to see default settings. Not all columns are on every grid. The following columns can be added:

**Alias**

Assigns an alternative name for a column or the real column name for a DBMS synonym.

**Application**

Indicates the application where the synonym resides.

**Belongs To Segment**

Shows the parent segment.

**Connection**

Indicates the adapter connection name used.

**Data Origin**

Indicates the date the synonym was created.

**Datetime Modified**

Indicates when the synonym was last modified.

**Description**

Is a description or comments about the column.

**Expression**

Is the expression for the column.

**Extension**

Indicates the suffix (data source type) of the synonym.

**Field Type**

Indicates that a column is an index (I) or is read-only.
**Format**

Is the type and length of a column data as stored.

**Function**

Indicates the name of the function.

**Has Foreign Keys**

Indicates that the synonym includes foreign keys.

**Index**

Indicates an index column.

**Join Conditions**

Indicates the conditions for the join.

**Join Parent**

Indicates the parent of the join.

**Join Strategy**

Indicates strategy for the join.

**Keys**

Indicates the keys in the synonym.

**Length**

Is the column length.

**Nulls**

Indicates whether or not the column can contain null data.

**Number of Segments**

Indicates the number of segments in the synonym.

**Order**

Indicates the order of the column in the segment.

**Prefix**

Indicates a prefix for the column.

**Primary Key Tables**

Indicates the primary key for the synonym.
**Property**
Indicates whether the column is an attribute or a measure.

**Real Table Name**
Indicates the actual name of the table or the physical file name.

**Reference**
Indicates a reference for the column to an index column.

**Scale**
Is the maximum number of digits to the right of the decimal.

**SCD Type**
Used for processing slowly changing dimensions.

**Segment**
Indicates the parent segment.

**Size**
Indicates the size of the synonym.

**Source**
Indicates the source of the synonym.

**SQL Conversion Notes**
Indicates how SQL is converted.

**Table**
Is the synonym that contains the column.

**Title**
Supplies a title to replace the column name normally used in reports.

**Type**
Is the type of object in an application directory.

The following columns are available from each column display option. The default columns are shown in bold.

- Business View Editor.

**Belongs to Segment, Format, Expression, Description, Nulls,** Segment, Type, Length, Scale, Alias, Title, SCD Type, Field Type, Index, Order, Property, Reference.
Caculator Functions.

Format, Description, SQL Conversion Notes.

Calculator Source.

Table, Format, Description, Nulls, Prefix, Segment, Type, Expression, Length, Scale, Alias, Title, SCD Type, Field Type, Index, Order, Property, Reference.

You can change the display order of the columns by moving them up or down using the arrows.

Reference: Synonym Editor Traces Options Settings

Trace option settings enable you to configure tracing for the server, as shown in the following image.

You can enable tracing for all components, default components, or a set of custom components. Trace output can be directed to the Web Console log (etlgprint.log), or to the tscom3.trc or connection.trc trace files.
Reference: **Synonym Editor Run Options Settings**

Run Options user preferences include determining the number of rows and columns to retrieve, as well as the default format when sampling data.

The Run Options settings window has the following fields and options:

**Maximum number of rows for test reports**

Sets the number of rows retrieved to produce sample data when testing transformations or SQL. The default is 50.

**Maximum number of columns for test reports**

Sets the number of columns retrieved to produce sample data when testing transformations or SQL. The default is to retrieve all columns (with a highest value setting of 999999).

**Test reports default format**

Sets the format of reports for retrieving sample data when testing transformations or SQL. The default is Default. There are seven report formats available:

- **Default.** Formats numeric and date columns based on edit options in the synonym.
- **HTML.** Produces the report in HTML format.
- **HTML - Plain Text.** Produces the report in plain text format.
- **active report.** Produces an HTML active report designed for offline analysis.
- **Excel.** Produces the report in Excel format.
- **PDF.** Produces the report in PDF format.
- **Unformatted.** Does not apply formatting to numeric and date columns.

**Stop after DBMS error**

Sets the number of DBMS-related errors allowed before the server stops running the procedure.

**Reference: Synonym Editor - Segment Context Menu**

When you right-click a segment in the Synonym Editor, the following context menu appears. This menu is available from the Field View and Segment View tabs.

The following image is an example of an SQL data source with the root segment selected.

The following options are available:

**Properties**

Opens a pane showing the properties of the selected segment.
Insert

Enables you to insert one of the following:

**Reference to Existing Synonym**

Adds a reference pointer from the current synonym to an existing synonym. The selection list will show candidate synonyms. If you subsequently make changes to the source synonym, reopening the current synonym will reflect those changes.

**Reference to Existing Synonym with Snowflake**

Adds a reference pointer from the current synonym to an existing synonym. The selection list will show candidate synonyms as well as any synonyms that they reference.

**Copy of Existing Synonym**

Adds a static copy of an existing synonym to the current synonym. If you subsequently make changes to the source synonym, the current synonym will not reflect those changes.

**Segment via Metadata Import**

Enables you to create and add a new synonym to the current synonym through the Create Synonym tool.

**Segment Manually**

Inserts a synonym that must be coded manually.

**Field**

Inserts a general column to the segment.

**Define**

Inserts a virtual or defined column to the segment.

**Filter**

Inserts a filter to the segment.

**Compute**

Inserts a calculated value to the file.

**Group**

Inserts a group column to the segment.
**Variable**

Inserts a variable name that can be used for a Synonym/Access File parameter.

**Data Profiling**

Provides the characteristics of the data for a segment.

Data Profiling is available from the right-click context menu for all columns in the Master File hierarchy tree.

**Sample Data**

Displays sample data in the workspace for the selected segment or synonym.

Sample data is available throughout the Synonym Editor toolbar.

The following image is an example of the sample data that appears for a segment.

![Sample Data](image.png)

**Note:** Sample data is a great way to test the synonym for field data and to view the type of records returned. This can assist when performing Joins, testing connectivity to data sources, and so on.

**Sample Data with parent key**

Displays sample data for the selected segment joined to the parent segment. This option is only available when a child segment is selected in a multisegment synonym.

**Delete**

Deletes the segment.
Rename

Enables you to rename the segment.

Join Properties

Opens the Join Editor so that you can specify how the selected segment is joined to the parent segment. This option is only available when a child segment is selected in a multisegment synonym.

Reference: Synonym Editor - Column/Field Context Menu

When you right-click a column in the Synonym Editor, the following context menu appears. This menu is available from the Field View, Segment View, and List View tabs.

The following image is an example of an SQL data source with a column selected.

Note: The options that are available will depend on the data source.

The following options are available:

Properties

Opens a pane showing the properties of the selected column.
**Insert**
Enables you to insert one of the following:

**Field**
Inserts a general column to the synonym.

**Define**
Inserts a virtual or defined column to the synonym.

**Filter**
Inserts a filter to the segment.

**Compute**
Inserts a calculated value to the file.

**Group**
Inserts a group column to the synonym.

**Variable**
Inserts a variable name that can be used for a Synonym/Access File parameter.

**Impact Analysis**
Displays an Impact Analysis report for the particular column in the workspace. An Impact Analysis report identifies the procedures that access a Master File or field within a Master File. For detailed information on Impact Analysis, see *Analyzing Metadata and Procedures* on page 197.

**Data Profiling**
Provides the characteristics of the data for a column. Data Profiling is available from the right-click context menu for all columns in the Master File hierarchy tree.

**Sample Data**
Displays sample data in the workspace.
The following image is an example of the sample data that appears for a column.

![Sample Data](image)

**Note:** Sample data is a great way to test the synonym for field data and to view the type of records returned. This can assist when performing Joins, testing connectivity to data sources, and so on.

**Decompose Date**

Decomposes date fields into virtual columns representing Year, Quarter, Month, and Day fields.

**Note:** Decompose Date is only visible for date fields.

**Delete**

Deletes the column.

**Rename**

Allows you to rename the column.
Reference: Synonym Editor - Field View Tab

The Field View tab shows a table with the available fields and segments.

The following image is an example of a Microsoft SQL Server data source in the Field View tab.
The row below the toolbar menu, which includes the Name, Format, Expression, Description, and Nulls, enables users to right-click and drag to move a column to the right or left, changing the column order in the display grid. You can not move the Name column. Users can also customize visible columns by right-clicking the row and selecting Customize, as shown in the following image.

The same menu displays when you right-click in an empty space. From this menu, a user is also given an option that enables them to switch views. More, the last option, opens the Column Management section of the Options dialog box. For more information, see Synonym Editor Column Management Settings on page 79.
**Reference: Synonym Editor - Segment View Tab**

The Segment View tab shows the segments that the synonym contains.

The following image is an example of a Microsoft SQL Server data source in the Segment View tab.

![Segment View Tab Example](image)

**Reference: Synonym Editor - List View Tab**

The List View tab shows a list of objects on the left, with the attributes and values of the selected item on the right, as shown in the following image.

![List View Tab Example](image)
**Note:** When you right-click a column heading in the List View, a context menu provides options to sort the display based on ascending or descending column values. The display can be sorted by any column.

**Reference:** **Synonym Editor - Modeling View Tab**

The Modeling View tab shows a graphical representation of the synonym. Use the Modeling View to, create cluster joins, view join properties, and add or edit segments.

The following image is an example of an SQL data source in the Modeling View.

In the Modeling View, when you right-click in an empty space, you are presented with tasks permitted in this view, for example, Insert a Segment and Auto Arrange available synonyms. For more information about the Modeling View, see *Enhancing Synonyms Using the Modeling View* on page 110.
Synonym Editor Layout

**Reference:** Synonym Editor - Text View Tab

This view opens the synonym in the editor.

You can print the Master File code by selecting Print from the File menu, perform search operations, and even make changes.

The following image is an example of a Microsoft SQL Server data source in the Text View tab.
**Reference:** Synonym Editor - Access File Text View Tab

The Access File Text View tab shows the description of the Access File for a synonym, which is used to access the database.

**Note:** You can print the Master File code by selecting Print from the File menu, performing search operations, and making changes, if necessary.

The following image is an example of an SQL data source in the Access File Text View tab.

![Example SQL data source in Access File Text View tab]

**Viewing and Editing Synonym Attributes**

The Synonym Editor enables you to view and edit the attributes of a synonym.

**Procedure:** How to View and Edit Synonym Attributes

To view and edit synonym attributes:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.

   By default, the Synonym Editor opens to the last view used, the Field View tab shows a hierarchy of segments and columns on the left, with the attributes and values of the selected item on the right.

   **Note:** The available attributes depend on the type of synonym.
The following image is an example of an SQL data source with a key column selected.

**Note:** The values for Format, Expression, Description, and Nulls are viewable in the hierarchy with the columns. To edit these values, use the corresponding attribute fields on the right-hand side of the Synonym Editor.

2. You can change the attribute values by typing in new values or by using the drop-down menus and check boxes.

**Note:** The Synonym Editor does not let you make any changes that would render the Master File unusable. Therefore, you cannot edit any value field that is highlighted gray. In addition, if a change does not have proper syntax or format applied, the field may appear in red text. Messages and warnings appear if you try to save a file that contains an error.

3. Save changes by clicking Save from the File menu.

4. To close the Synonym Editor, select Close from the File menu or click the control button in the upper-right corner.

**Note:** If you close the Synonym Editor without saving your changes, you are prompted to save.
Reference: File Attributes Summary

The following image is an example of an SQL data source with the synonym file name selected.

![Image of SQL data source]

**Note:** Information about the attribute that has focus is displayed at the bottom of the attribute list. In this case, an explanation of the SUFFIX attribute appears.

Synonyms can have the following file attributes:

**General**

1. **SUFFIX**
   - Identifies the type of synonym or data source.

2. **MFD_PROFILE**
   - The name of the FOCEXEC that will be executed before a request containing MFD.

3. **FDEFCENT**
   - Defines the default century value, specifying a century number for handling cross-century dates.

   **Note:** Use the default setting (0) unless you wish to retrieve data from an earlier century. For example, 19xx.

4. **FYRTHRESH**
   - Defines the base years, to represent the lowest year to which the century value applies (FDEFCENT).
**Note:** Use the default setting (0) unless you wish to retrieve data from an earlier century. For example, 19xx.

**REMARKS**

Enables you to include descriptive information at the file level and specify multiple language descriptions for the synonym. Remarks are displayed along with the file name during reporting.

For more information about multilingual descriptions, see *Setting Up Multilingual Titles and Descriptions* on page 106.

**DATASET**

Identifies the physical location of the data source to be used in the file name, including the extension and the location of the data file.

**Note:** The available attributes depend on the type of synonym.

**Reference:** Segment Attributes Summary

The following image is an example of an SQL data source with a segment selected.

![Segment Attributes Summary](image)

**Note:** Information about the attribute in focus is displayed at the bottom of the attribute list. In this case, an explanation of the SEGMENT attribute appears.
Segments in a synonym can have the following attributes:

**General**

**SEGMENT**
Is the name of the segment.

**ENCRIPT**
Check this box to scramble field values in the current segment in order to protect it from unauthorized examination.

**Note:** You must assign a DBA password to the file before setting the Encrypt option on. For details, see *Encrypting and Decrypting a Master File* on page 194. You must then turn the Encrypt option on before adding any records. If you add a record to a segment before setting the Encrypt option on, that value will not be encrypted.

Once a segment is encrypted, you can remove encryption only if you remove the segment and recreate it without turning the Encrypt option on.

**Tip:** Because there is a loss of processing efficiency when data is encrypted, encryption should be used selectively.

**SEGTYP**
Specifies the type or relationship that a segment has to its parent and indicates which of the segment fields are key fields, and in what order they are sorted.

**Type.** Identifies the segment type and sorting options from the Type drop-down list.

**Keys.** Records are sorted in a data source by key fields. Enter the number of key fields that you want to use for sorting. For example, no two employees can have the same employee ID number, so you can use that field as the key. A segment instance can have more than one field that makes up the key. That is, two or more field values may be used to distinguish records.

**SEGSUF**
SEGSUF is used when part of the data source being described by the Master File is of a different data source type than that declared for the entire structure.

**Note:** SEGSUF is the data source type of a segment and any descendants it might have, where that type differs from the SUFX value.
**Miscellaneous**

**DESCRIPTION**
Contains a description or comments about the segment.

For more information about multilingual descriptions, see *Setting Up Multilingual Titles and Descriptions* on page 106.

**CRFILENAME**
Is the name of the cross-referenced data source.

**CRSEGNAME**
Is the name of the cross-referenced segment.

**CRKEY**
Identifies the common join field for the cross-referenced segment.

**Adapter Specific**

*Note:* Adapter Specific fields are shown if an Access File component has been generated with the synonym.

**CARDINALITY**
Defines the number of records that were found in the original data source when the synonym was created.

**TABLENAME**
Identifies the table or view. It may contain the owner ID, as well as the table name. For some synonyms, it must also contain the data source name.

**CONNECTION**
Indicates the adapter connection name used.

**KEYS**
Identifies how many columns constitute the primary key.

**KEYORDER**
Identifies the logical sort sequence of data by the primary key.

**WRITE**
Specifies whether write operations are allowed against the table.
**DBSPACE**

Identifies the storage area in which the table resides.

**PERSISTENCE**

Specifies the type of table persistence and related table properties. This is optional for database management systems that support volatile tables, and required otherwise.

**Note:** The attributes available depend on the type of synonym.

**Reference:** Column/Field Attribute Summary

The following image is an example of an SQL data source with a key column selected.

**Note:** The attributes available depend on the type of synonym.

Columns in a synonym can have the following attributes:

**General**

**FIELDNAME**

Is the name of the column.
ALIAS
Assigns an alternative name for a column or the real column name for a DBMS synonym.

MISSING
Controls how null data is handled, that is, if no transaction value is supplied.

TITLE
Supplies a title to replace the column name that is normally used in reports and enables you to specify multiple language titles for the column or field.

For more information about multilingual titles, see Setting Up Multilingual Titles and Descriptions on page 106.

ACTUAL
Describes the type and length of data as it is actually stored in the data source.

USAGE
Describes the data type and format for the column for usage or display.

Note: Additional attributes, DEFCENT and YRTHRESH, are available if the Usage field is set to Date, Time, or DateTime (Timestamp) format. Use these attributes to enter the century and year threshold values for the column or field.

- **Type.** Enables you to set a value for the field as Alpha fixed, Alpha variable, Text, Integer, Float, Double, Decimal Packed, Date, Time, DateTime (Timestamp), and Binary Large Object.
- **Length.** Enables you to set the character length.
- **Options.** Enables you to set how negative integers appear, set the appearance or suppression of commas, set leading zeroes, print blank for zeroes, set percentage signs, and select currency symbols.

Miscellaneous

DESCRIPTION
Contains a description or comments about the column or field.

For more information about multilingual descriptions, see Setting Up Multilingual Titles and Descriptions on page 106.
 ACCEPT
 Specifies criteria for validating data.

 OR. Enables you to specify an acceptable value.

 FROM-TO. Enables you to specify a range of acceptable value fields.

 FIND. Enables you to supply file and field names to instruct WebFOCUS where to search for a data source, and for a list of acceptable values. You supply the field name of the data field for which the validation criteria are being assigned, the file name of the target FOCUS data source where the field can be found, and the field name of the target data field that contains the validation criteria.

 Note: FIND is only available for FOCUS data sources and does not apply to OLAP-enabled Master Files. Note also that in the Maintain environment, FIND is not supported when developing a Master File.

 WITHIN
 Contains the name of a field to be included in a dimension.

 These WITHIN statements are added to the synonym through the Dimension Builder to OLAP-enable FOCUS files and relational tables. This enables you to perform OLAP analysis using the OLAP Control Panel or to use it with the Financial Report Painter.

 Property
 Sets the Property for the field.

 Reference
 Enables you to reference another data source.

 FIELDTYPE
 Identifies an indexed column. You can check the Index check box to index the FIELDTYPE.

 Note: FIELDTYPE=R indicates a read-only column. This setting is useful for columns that are automatically assigned a value by the RDBMS.

 ACCESS_PROPERTY
 Specifies access options for the column data.
- **INTERNAL.** Defines a column that does not appear in sample data or in the list of available columns. Restricts the field from showing in any of the Field Lists in the reporting tools.

- **NEED_VALUE.** Defines a column that requires a value to access the data.

- **Select By.** Defines a column by value, range, or multivalues.

**AUTHRESP**

Defines a column that describes the result of an authentication operation. Correct response values must be provided in the ACCEPT attribute (using the OR predicate if more than one value is acceptable).

**AUTHTOKEN**

Defines a column that contains a response token to be passed as an input value to the operation to be executed.

**HELPMESSAGE**

Appends a help message to a column.

**USE_STYLE**

Is the name of the stylesheet applied to a field.

### Setting Up Multilingual Titles and Descriptions

You can open a synonym in the Synonym Editor and provide text for the title, caption, and description in multiple languages. These descriptions appear in the specified language in reports generated against the synonym.

The Multilingual Titles dialog box is available from the Remarks, Title, and Description attribute value fields in the Synonym Editor.

**Note:** The attributes available depend on the type of synonym.

**Procedure: How to Set Up Multilingual Titles and Descriptions**

1. From the Projects or Data Servers area, double-click the Master File or select *Edit in Synonym Editor* from the File menu.

   The Master File opens to the Field View tab in the Synonym Editor.

2. To add multilingual text:
   - For *Title*, click a column from the Master File hierarchy of columns on the left.
For Remarks, click the root level of the Master File (application/filename) on the left.

For Descriptions, click a column, segment, or custom field from the Master File hierarchy of fields on the left.

The corresponding attributes and values appear on the right.

3. Click the browse (...) button at the end of the value field for either Remarks, Title, or Description.

The Multilingual dialog box opens.
4. From the Specify Titles/Descriptions for different languages drop-down list, choose the language in which you want the titles or remarks (descriptions) to be displayed.

5. Click Add.
The selected language is added below the default language (which is determined by your code page selection).

6. Type a description or title in the Text field.
7. You may add, edit, or delete additional titles or descriptions.

   **To add an additional language:**
   a. Select another language from the drop-down list.
   b. Click *Add*.
   c. Type a title or description for the field.

   **To edit an existing specified title or description:**
   a. Select the title or description and click *Edit*.
      You may also double-click the title.
   b. Manually type a title or description name.

   **To delete a specified title:**
   a. Select the title or description and language to be deleted.
   b. Click *Delete*.

8. Click *OK* to close the Multilingual Titles dialog box.

9. Click *Save* from the File menu to save the synonym.

10. To close the synonym, select *Close* from the File menu or click the control button in the upper-right corner.

---

**Enhancing Synonyms Using the Modeling View**

The Synonym Editor Modeling View tab provides a visual presentation for the synonym for which positioning is preserved and stored in the Access File. Use the Modeling View to define dimensions for OLAP analysis, view join properties, create cluster joins, and add or edit segments. For more information about using the Dimension Builder in the Modeling View, see *Defining Dimensions for OLAP Analysis* on page 136.

**Note:** The Modeling View is not available for Cube data sources.

**Procedure: How to Enhance Synonyms Using the Modeling View**

Use the Modeling View to enhance a synonym by adding a segment.

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   The Synonym Editor opens.
2. Click the *Modeling View* tab.

The Synonym Editor Modeling View tab opens in the workspace.

3. Right-click a segment in the workspace.

The following context menu appears.

4. Insert segments through one of the methods listed:

   - Insert Reference to Existing Synonym adds an existing synonym as a segment to the current synonym.
   - Insert Reference to Existing Synonym with Snowflake adds an existing synonym as a segment to the current synonym. The selection list will show candidate synonyms as well as any synonyms that they reference.
   - Insert Copy of Existing Synonym enables you to add a table as a segment from an existing synonym.
   - Insert Segment via Metadata Import enables you to add segments by using the Create Synonym tool. This tool creates a synonym and includes it as a segment in the synonym from which the tool was launched.
   - Insert Segment Manually enables you to add segments manually to the current synonym.

**Note:** You would use this approach only if you are coding a new Master File, as you would for a FOCUS data source.
Procedure: How to Edit Synonyms Using the Modeling View

To edit synonyms using Modeling View:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
   The Synonym Editor opens.

2. Click the Modeling View tab.

3. Right-click a segment icon.

   A context menu appears, providing options for adding segments.

   **Note:** Options for adding segments are also available from the icons above the workspace.

   ![Context Menu Example]

   **To insert a segment from an existing synonym:**

   a. Select Insert, then Reference to Existing Synonym from the context menu.
The Insert Reference to Existing Synonym dialog box opens.

Columns can be customized and sorted. Synonyms displayed in this dialog box are based on the Reporting Servers APP Path configuration.

b. Click a synonym and click Select.

The segment is added to the synonym.

To insert a segment from an existing synonym with Snowflake:

a. Select Insert, then Reference to Existing Synonym with Snowflake from the context menu.

The procedure is the same as Reference to Existing Synonym, except the selection list will show both candidate synonyms and any synonyms that they reference.

To insert a segment via Metadata Import:

a. Select Insert, then Segment via Metadata Import from the context menu.
This method enables you to launch the Create Synonym tool, create a synonym, and incorporate it as a new segment in the synonym from which you initiate the import.

b. When this option is selected, you are first presented with the Select Adapter dialog box where you can select a configured adapter connection to continue or configure a new adapter, if necessary, as the following example demonstrates.

The following image is an example of a screen where you provide information for the connection parameters.
The following image is an example of a screen that enables you to select tables to create synonyms.

![Screen example](image)

The segment is added to the synonym.

**To insert a segment manually:**

**a.** Select *Insert*, then *Segment Manually*.

The segment is added to the Modeling View and a default field is created, using a default segment name.

**b.** Attributes for the new segment or segments can be modified in the Modeling View tab through the Properties window or from the other views.
The following image shows a synonym that has had several segments added in the Modeling View tab.

The following image shows the resulting Text View.
The following image shows the resulting Access File Text View.

![Access File Text View](image)

**Reference:** **Modeling View Context Menu**

When you right-click a synonym or segment in the Synonym Editor Modeling View tab, the following context menu appears.

![Context Menu](image)

The context menu has the following options:

**Collapse Segment**

Changes the view from a file icon to a table view, which enables you to see columns, sample data, and sample data parent keys.
Tip: You may also double-click a file icon to open the table view. Double-click the table to close the table view, or click the X button from the toggle toolbar to close.

**Join Properties**

Provides access to the Join Properties window.

**Note:** Join options are not available for FOCUS files.

**Data Profiling**

Provides the characteristics of the data for a segment.

**Sample Data**

Displays sample data in the workspace.

**Sample Data with parent key**

Displays sample data with parent key in the workspace.

**Insert**

- **Reference to Existing Synonym.** Enables you to reference an existing synonym as a segment to the current synonym.

- **Reference to Existing Synonym with Snowflake.** Enables you to reference an existing synonym as a segment to the current synonym. The selection list will show candidate synonyms as well as any synonyms that they reference.

- **Copy of Existing Synonym.** Copies an existing synonym to the current synonym.

- **Segment via Metadata Import.** Enables you to create a new synonym through the Create Synonym tool and add it to the current synonym.

- **Segment Manually.** Inserts a segment to the current synonym, that must by coded manually.

**Delete**

Deletes the segment.

**Rename**

Enables you to rename the segment.
Reference: Join Editor Dialog Box

When you select Join Properties from a segment in the Synonym Editor Modeling View tab, the Join Editor dialog box appears.

The Join Editor dialog box contains Left and Right Source columns, Join Type, and Join Condition options, as well as One-to-Many and One-to-One choices. Use the left and right source columns to create join maps and view sample data.

Note: Join options are not available for FOCUS files.
Viewing Data Profiling Characteristics

Data Profiling provides data characteristics for the columns in a synonym. You can display the characteristics for all the columns in a synonym or segment, or for an individual column.

For alphanumeric columns, Data Profiling provides the segment, format, count of distinct values, total count, patterns count, maximum, minimum, and average length, minimum and maximum values, and number of nulls. Patterns count shows the number of patterns found in each alphanumeric column.

For numeric columns, Data Profiling provides the segment, format, count of distinct values, total count, maximum, minimum, and average values, and number of nulls.

Data Profiling for an individual column provides access to Statistics, Patterns, Values, and Outliers reports.

Data Profiling a Synonym or Segment

Data Profiling provides information on all the columns in a synonym or segment. You can also drill down to the Values or Patterns reports for an individual column from a synonym or segment Data Profiling report.

Procedure: How to View Data Profiling for a Synonym or Segment

To view the Data Profiling information for a synonym or segment:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.

   By default, the Synonym Editor opens to the last view used.

2. Right-click the synonym or segment name, select Data Profiling, and then Statistics.

   The Data Profiling information displays in the workspace. The last four columns are shown below the rest of the information for illustrative purposes only. The actual report runs across the workspace.

   You may use the Data Profiling Results toolbar to view server messages, print the report, copy data as text, and export the report.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to drill down to the Values or Patterns reports, respectively.

   This is a partial Values report produced by clicking a column name.
For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an a represents any lowercase letter. All printable special characters are represented by themselves and unprintable characters are represented by an X.

Data Profiling Columns

Data Profiling can be done for all the columns in a synonym or segment (press the Shift or CTRL key while selecting multiple columns), or for an individual column. Data Profiling for an individual column provides access to the following reports:

- **Statistics.** Shows the same information as a Data Profile report for a synonym or segment.
  
  For alphanumeric columns, the Statistics report provides the segment, format, count of distinct values, total count, patterns count, maximum, minimum, and average length, minimum and maximum values, and number of nulls.

  For numeric columns, the Statistics report provides the segment, format, count of distinct values, total count, maximum, minimum, and average values, and number of nulls.

- **Patterns.** Only available for alphanumeric columns, shows patterns of letters, digits, and special characters, as well as counts and their percents.

- **Values.** Shows unique values and their percents.

- **Values Graph.** Displays a graph for alphanumeric field types.

- **Values Pie Graph.** Displays a pie graph for alphanumeric field types.

- **Duplicate Values.** Shows identical values and their percents.

- **Outliers.** Shows the ten highest and lowest distinct values and their counts.

These reports are available by right-clicking a column in the Synonym Editor and selecting Data Profiling.

**Procedure:** How to View Data Profile Statistics

To view the Statistical Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.

   By default, the Synonym Editor opens to the last view used.

2. Right-click a column, select Data Profiling, and then Statistics.
The Statistical Data Profiling information opens in the workspace, as shown in the following image.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to drill down to the Values or Patterns reports, respectively.

**Procedure: How to View Data Profile Patterns**

Data Profile Patterns shows patterns of letters, digits, and special characters, as well as counts. This is only available for alphanumeric columns.

To view the Patterns Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.

   By default, the Synonym Editor opens to the last view used.

2. Right-click a column, select Data Profiling, and then Patterns.
The Patterns Data Profiling information displays, as shown in the following image.

For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an a represents any lowercase letter. All printable special characters are represented by themselves and unprintable characters are represented by an X.

**Procedure:** How to View Data Profile Values

Data Profile Values shows unique values.

To view the Values Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.

   By default, the Synonym Editor opens to the last view used.

2. Right-click a column, select Data Profiling, and then Values.
The Values Data Profiling information displays, as shown in the following image.

![Values Data Profiling Information](image)

**Procedure:**  **How to View the Data Profile Values Graph**

The Data Profile Values Graph displays values as a bar graph.

To view the Values Graph Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
   By default, the Synonym Editor opens to the last view used.

2. Right-click a column, select *Data Profiling*, and then *Values Graph*. 


The Values Graph Data Profiling information displays, as shown in the following image.

**Procedure: How to View the Data Profile Values Pie Graph**

The Data Profile Values Pie Graph displays values as a pie graph.

To view the Values Pie Graph Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
   By default, the Synonym Editor opens to the last view used.

2. Right-click a column, select *Data Profiling*, and then *Values Pie Graph*. 
Procedure: How to View Data Profile Duplicate Values

Data Profile Duplicate Values shows identical values.

To view the Duplicate Values Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
2. Right-click a column, select Data Profiling, and then Duplicate Values.
The Duplicate Values Data Profiling information displays, as shown in the following image.

![Duplicate Values Data Profiling](image)

**Procedure: How to View Data Profile Outliers**

Data Profile Outliers shows the ten highest and ten lowest distinct values.

To view the Outliers Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
   By default, the Synonym Editor opens to the last view used.

2. Right-click a column, select *Data Profiling*, and then *Outliers*. 
The Outliers Data Profiling information displays, as shown in the following image.

![Outliers Data Profiling](image)

**Note:** Outliers produce a maximum of the ten highest and ten lowest distinct values, if they exist.

### Creating Cluster Joins

Cluster joins enable you to create a new file structure by linking existing synonyms of two or more relational tables using the same or mixed data sources. For example, you may join a DB2 table and an Oracle table, and so on. Use cluster joins to create new views in the metadata by linking together physical tables and easily report against the new view or structure. You can create cluster joins by using the Modeling View of the Synonym Editor.

The Master File that is created combines the fields of the joined tables within a single file. The Access File from the combined file contains information about the actual location of the data sources and the Join information. It also shows how the tables are linked.

The total number of tables that you can add to the tool is 64 (using 63 joins), which results in a new Master File that has a maximum of 64 segments.

The Cluster Join tool enables you to create a Star Schema which consists of a fact table referencing a number of dimension tables. Optionally, you can also create a view that has more than one fact table.
Procedure: How to Create a Cluster Join by Enhancing Existing Synonyms

Use the Modeling View to enhance an existing synonym by adding a segment.

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
The Synonym Editor opens.

2. Click the Modeling View tab.
   
The Synonym Editor Modeling View tab opens in the workspace.

3. Right-click a segment in the workspace and select Insert.
   
The following context menu appears, as shown in the following image.

4. Insert tables (segments) through one of the methods listed:

   To insert a segment from an existing synonym:
   
   a. Select Insert, then Reference to Existing Synonym.
The Insert Reference to Existing Synonym dialog box opens, as shown in the following image.

![Insert Reference to Existing Synonym dialog box](image)

b. Select a synonym to be inserted and click Select.

**Note:** Use this method if you are creating a cluster join with an existing table or synonym.

**Tip:** Click Save As from the Modeling View File menu if you do not want to modify the original synonym.

**To insert a segment from an existing synonym with Snowflake:**

Select Insert, then Reference to Existing Synonym with Snowflake.

The procedure is the same as Reference to Existing Synonym, except the selection list will show both candidate synonyms and any synonyms that they reference.
To insert a segment via Metadata Import:

a. Select Insert, then Segment via Metadata Import. This enables you to add segments by using the Create Synonym tool. This tool creates a synonym and includes it as a segment in the synonym from which the tool was launched.

   **Note:** Use this method if you are creating a cluster join and need to use a synonym that does not exist. This option enables you to create the synonym and continue to create the cluster join.

b. When this option is selected, you are first presented with the Adapter dialog box where you can select a configured adapter connection to continue or configure a new adapter, if necessary. The Adapter dialog box is shown in the following image.
The following image is an example of a screen that appears where you provide information for the connection parameters.

The following image is an example of a screen that enables you to select tables to create synonyms.
The selected synonyms will be created and added to the Modeling View.

**To insert a segment manually:**

Select *Insert*, then *Segment Manually*. This enables you to assign values to segment attribute fields in the Synonym Editor.

**Note:** Use this method if you are coding a new Master File, as you would for a FOCUS data source.

The segment is added in the Modeling View.
5. Right-click a segment and select *Join Properties*, as shown in the following image.

**Note:** This option is only available when using relational tables.
The Join Editor dialog box opens, as shown in the following image.

6. Select a radio button for One-to-Many (Join All) or One-to-One (Join Unique).
   - **One-to-Many.** Indicates a multiple-instance join. At run time, each host record can have many matching records in the cross-referenced file.
   - **One-to-One.** Indicates a single-instance join. At run time, each host record has, at most, one matching record in the cross-referenced file.

7. Select a Join Type from the drop down menu. The choices are Inner, Left Outer, or Cross Join.

The Join Condition field automatically creates a Join if identical fields exist in both segments.

**Procedure: How to Create a Cluster Join Using a New Synonym**

Another way to create a cluster join is to start with an empty synonym:
1. Right-click a Master Files folder, select New, then Synonym via Synonym Editor. The New Master File dialog box opens.

2. Enter a unique file name in the File name field.

3. Click Create.

   The Synonym Editor opens.

4. Click the Modeling View tab.

5. Right-click in the workspace and select from one of the available options to start building the new view.

---

**Defining Dimensions for OLAP Analysis**

Synonyms can be modified to support Online Analytical Processing (OLAP). The Synonym Editor provides tools to create OLAP hierarchies and dimensions. OLAP enables you to drill down or roll up on hierarchical data, pivot fields from columns to rows (or vice versa), and slice-and-dice information by filtering or querying data sources based on specified criteria thresholds.

You OLAP-enable the Master File by using the Synonym Editor to create dimension(s) at the field level and associate fields with each dimension.

**Note:** OLAP is a reporting facility. It is not relevant to data maintenance projects.
Using the Dimension Builder in the Synonym Editor Modeling View

The Dimension Builder enables you to create logical views based on enterprise data (relational or legacy data sources) for multidimensional analysis without manually editing metadata. The Dimension Builder works with relational and FOCUS data sources. You can enable the Dimension Builder by selecting Dimension Builder from the toolbar or the Tools menu.

**Procedure: How to Add a Parent/Child Hierarchy**

1. From the Synonym Editor, click the **Modeling View** tab.

2. Click the **Dimension Builder** icon on the toolbar.
   
   The Dimension Builder opens.

3. Click the **Parent/Child Hierarchy** icon from the Dimension Builder toolbar.
   
   The Mandatory Properties for Parent/Child Hierarchy dialog box opens.

4. Select a field from the Field Tree and click **Assign** to assign a Unique ID for the hierarchy.
5. Repeat step 4 for the Caption and Parent hierarchy properties.
6. Click OK to close the Mandatory Properties for Parent/Child Hierarchy dialog box.
   The Mandatory Properties are added to the Dimension Builder.
7. Use the right-click menu to rename the dimension, view properties, or view sample data for the dimension.
8. Click Save from the File menu to save the dimension.

**Procedure: How to Delete a Dimension**
To delete a dimension, right-click a dimension and select Delete, or click the Delete button from the Dimension Builder toolbar.

**Procedure: How to Add Levels to the Hierarchy**
This process enables you to edit an existing Master File, add tables (for non-FOCUS Master Files), and create and modify dimensions.

1. From the Synonym Editor, click the Modeling View tab.
2. Select the Levels Hierarchy button from the Dimension Builder toolbar.

A level is added to the hierarchy. Use the right-click menu to rename the dimension or keep the default name.
3. Drag the selected fields from a segment into the Dimension Builder hierarchy folder.

4. Click Save from the File menu to save the dimension. The dimension is saved and stored in the Master File.

Reference: **Dimension Builder Toolbar**

You can access the following commands from the Dimension Builder toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Adds a level hierarchy.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Enables you to create a parent/child hierarchy and assign mandatory properties for the hierarchy.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Deletes the selected item.</td>
</tr>
</tbody>
</table>
### Using the Synonym Editor for Cube Data Sources

The Synonym Editor enables you to make further modifications to your Cube synonym definitions. The Cube synonym is displayed in the Cube View tab. If you select a component of the synonym, its properties appear in the Properties pane.

You can use the Synonym Editor to:

- Edit field names and titles for measures, properties, and variables. You may also edit the field prefix for the defined fields.

- Edit titles for multiple languages, delete titles, and add titles for additional languages if you are using code page UTF-8.
- Delete measures, dimensions, or parent/child hierarchies.
- View the USAGE and ACTUAL formats and change the USAGE display format for the field.
- Change an internal attribute value.
- Change the access property for variables.
- Change the field prefix used to create the field names, mandatory property names, and DEFINE field names generated for parent/child hierarchies by the Synonym Wizard.
- Create virtual measures (this is implemented with COMPUTE fields in the Master File).

The following image is an example of a Cube data source in the Synonym Editor.

**Note:** The Synonym Text View tab and the Access File View tab are identical for all types of data sources. For more information about these tabs, see Synonym Editor - Text View Tab on page 96 and Synonym Editor - Access File Text View Tab on page 97.

**Reference:** Cube View Tab Objects

The following objects appear on the Cube View tab.
### Object | Description
--- | ---
Characteristics. Contains the Properties and Hierarchies folders. | 
Optional variable. | 
Mandatory variable that is not satisfied (selection criteria has not been created). | 
Mandatory variable that is satisfied (selection criteria has been created). | 
Measure Group. | 
Measure. | 
Hierarchy. | 
Hierarchy Field. Represents a leaf node in a parent/child hierarchy. A leaf node is a member of a hierarchy that does not have any children. | 
Attribute Folder. | 
Attribute. | 
Virtual Attribute or Virtual Measures Folder. | 
Virtual Attribute Folder. |

For more information about other standard objects that may appear in the Synonym Editor, see *Synonym Editor Main Attributes* on page 72.

**Procedure:** How to Edit Field Names and Titles

To edit field names and titles:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master File from the Master Files folder.
**Note:** You may also right-click the synonym and select *Edit in Synonym Editor.*

By default, the Synonym Editor opens to the last view used.

2. Select an attribute from the Cube View tab.

**Note:** The attributes available depend on the type of synonym.

3. Click *FIELD NAME, TITLE,* or *CAPTION* on the right-hand side of the workspace.

**Note:** The Synonym Editor does not let you make any changes that would render the Master File unusable. Therefore, you cannot edit any value field that is highlighted gray.

4. Manually edit the Field Name, Title, or Caption by typing in the value field.
   
The edits are updated instantaneously in the Cube View tab.

5. Click Save to save the synonym.

6. To close the synonym, select *Close* from the File menu or click the control button in the upper-right corner.

**Procedure: How to Edit Titles for Multiple Languages**

To edit the title for multiple languages:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master File from the Master Files folder.
   
   By default, the Synonym Editor opens to the last view used.

2. Select an attribute from the Cube View tab.

3. Click the browse (…) button, located on the far right of the TITLE or CAPTION value field.
   
The Multilingual Titles dialog box opens.
4. You may add, edit, or delete a title for this field.

   **To add an additional language for the title:**
   a. Select a language from the drop-down list.
   b. Click *Add*.
   c. Type a description for the title field.

   ![Multilingual Title Dialog Box](image)

   **To edit an existing specified title:**
   a. Select the title and click *Edit*.
      You may also double-click the title.
   b. Manually type a title name.

   **To delete a specified title:**
   a. Select the title and language to be deleted.
   b. Click *Delete*.

5. Click *OK* to close the Multilingual Titles dialog box.
6. Click *Save* from the File menu to save the synonym.
7. To close the synonym, select Close from the File menu or click the control button in the upper-right corner.

**Procedure: How to Delete Measures, Dimensions, or Parent/Child Hierarchies**

To delete measures, dimensions, or parent/child hierarchies:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master File from the Master Files folder.
   
   By default, the Synonym Editor opens to the last view used.

2. Select the attribute name that you want to delete.

3. Right-click and select *Delete* from the context menu.
   
   The attribute is deleted from the Cube View tab.

4. Click *Save* to save the synonym.

5. To close the synonym, select *Close* from the File menu or click the control button in the upper-right corner.

**Procedure: How to Create Virtual Measures With COMPUTE Fields**

To create virtual measures with COMPUTE fields:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master File from the Master Files folder.
   
   By default, the Synonym Editor opens to the last view used.

2. Open the *Measures* folder from the Cube View tab.
3. Right-click the *Virtual Measures* folder, select *Insert*, and then *Virtual Measure*.

The Compute Calculator opens.

4. From the Compute Calculator, type a name for the column in the *Name* field.
5. You may type a descriptive title for the measure (COMPUTE) in the *Title* field.
6. Use the Expression tab and the calculator buttons to build the expression for the Measure (COMPUTE field).

   or

   Use the Relational Expression tab to build the expression.

   a. From the Relational Expression tab, click the Add New Row button.

   b. Use the drop-down lists to select the Field, Relation, and Type.

   **Note:** Parameters are not supported.

   c. Click the browse (…) button at the right of the Value input field.

   d. Select from the available values and use the arrows to add or remove values.

   e. Click OK to close the Value Selection dialog box and return to the Relational Expression tab.

   The expression is added to the virtual measure.

   f. To add another expression, double-click a measure or dimension from the Fields/Variables tab on the right side of the Compute Calculator.

   The expression is added to the Relational Expression tab, where you can add the expression value.

   g. To delete an expression, select the number or field column of the expression and click the Delete button, or right-click it and select Delete selected row(s). The expression is removed from the Relational Expression tab.

7. You may click the Check expression and Sample Data buttons, located on the top right of the Compute Calculator, to verify that the expression is valid and to view sample data for the filter.

8. Click OK to close the Compute Calculator and return to the Synonym Editor.
Creating Business Views

By defining a Business View of a Master File, you are creating an alternative view of the Master File and can limit the fields available or create a subset of fields from the original Master File. Fields can be grouped into meaningful folders. Field names, titles, and descriptions can be customized for each Business View.

Fields in a Business View are organized into folders. Each folder contains a group of fields. The fields in a folder can come from different segments in the original Master File. The Business View may contain existing fields and can include existing custom fields for DEFINE, COMPUTE, and Filters. Custom fields are associated with a specific segment in the original Master File and are subject to the same rules as real fields. A report can reference fields from multiple folders if they all lie along a single path in the original Master File.

When opening a Master File in the Synonym Editor and clicking the Business View button on the toolbar, a Business View pane opens inside the Synonym Editor where Business View attributes can be added. Adding Business View attributes at this point would update the Master File by inserting the Business View attributes at the end of the file, and once the file is saved, the Business View becomes the active view when the file is used for reporting.
If you do not wish to turn your Master File into a Business View, it is recommended that you save the Business View using a different name or preferably start by creating a new Master File by selecting New, then Synonym via Synonym Editor. Then, insert a reference to an existing synonym and continue to build the Business View. In this case, the Business View points to the cross-referenced Master File, and all of the actual fields and security information comes from the referenced file when the Business View is used in WebFOCUS tools (such as Joins and Defines) and in reports.

**Note:** Impact Analysis searches Business Views in addition to FOCUS procedures. This enables you to see if changes in the original Master File will impact fields used in the Business View. For detailed information on Impact Analysis, see *Analyzing Metadata and Procedures* on page 197.

You may create a Business View for an existing Master File by using the Synonym Editor.

**Procedure:** How to Create a Business View Using the Synonym Editor

1. From the Projects or Data Servers area, navigate to the Master Files folder where you want to create the Business View.
2. Right-click the Master Files folder and select New, then Synonym via Synonym Editor.
3. Provide a unique name for the new file and click Open or Create if in the Data Servers area.
4. While in the Field View tab of the Synonym Editor, right-click the file name in the upper-left corner, select Insert, and then Reference to Existing Synonym.
5. From the Insert Reference to Existing Synonym dialog box, select the synonym for which you want to create a Business View. For FOCUS multisegment files, you have the option to select the segment you want to reference.
   
   The referenced file is added to the new synonym and its fields are visible in the left frame.
6. Select Business View from the Tools menu to open the Business View pane. You can also click the Business View icon from the Synonym Editor.
**Note:** A Business View Master File may contain only one root folder.

**Tip:** Select Properties from the Tools menu to open the Properties pane and view additional information for items selected in the Business View pane. Use the Properties pane to change titles, descriptions, or field names. Items that cannot be edited are grayed out.

7. In the Business View pane, right-click the file name and select *Create Default Business View* or *New Folder*.

   The *Create Default Business View* option duplicates the segments and fields that are available in the Master File. You can reorganize the view as necessary. The *New Folder* option creates a root folder to which you can add fields from the Master File on the left pane by selecting them and then dragging them inside the folder. You can create additional folders to create the structure you want.

8. To add additional folders for the Business View, right-click the Business View root folder that was created in the Business View pane and select *New Folder*.

   **Note:** Multiple subfolders can be created and folders may be empty for organizational purposes.
9. Select fields from the Master File on the left and drag them to the appropriate folder in the Business View pane. Press the Shift or Ctrl key while selecting multiple fields.

**Note:** If needed, fields may be duplicated by placing them in multiple folders, but any given folder may contain a field only once.

The selected fields appear in the Business View pane.

10. Select the Save or Save As icon to save the Business View as a Business View Master File.

**Note:** The Business View Master File may be saved in a different application than the main files.

**Procedure:** How to Alternatively Create a Business View Using the Synonym Editor

It is recommended that you create a Business View using the Synonym Editor as outlined in *How to Create a Business View Using the Synonym Editor* on page 149. However, the following is an alternative way to create a Business View using the Synonym Editor.

1. From the Projects or Data Servers area, navigate to the Master Files folder where you wish to create the Business View and highlight the Master File to be altered.

**Note:** You may create a Business View anywhere that you can select a Master File.
2. Double-click the Master File or select *Edit in Synonym Editor* from the File menu. 

The Master File opens to the Field View tab in the Synonym Editor.

**Note:** When opening a Master File in the Synonym Editor, the tool opens to the last tab selected when the Synonym Editor was last accessed.

3. Select *Business View* from the Tools menu. You can also click the Business View icon from the Synonym Editor.

The Business View pane opens.

**Note:** A Business View Master File may contain only one root folder.

4. In the Business View pane, right-click the file name and select *Create Default Business View* or *New Folder*.

The *Create Default Business View* option duplicates the segments and fields that are available in the Master File, and you can reorganize the view as necessary. The *New Folder* option creates a root folder to which you can add fields from the Master File on the left pane by selecting them and then dragging and dropping them inside the folder. You can create additional folders to create the structure you want.
5. To add additional folders for the Business View, right-click the Business View root folder that was created in the Business View pane and select New Folder.

**Note:** Multiple subfolders can be created and folders may be empty for organizational purposes.

6. Select fields from the Master File on the left and drag and drop them to the appropriate folder in the Business View pane. Press the Shift or Ctrl key while selecting multiple fields.

   The selected fields appear in the Business View Tree tab.

   ![Business View Tree Tab](image)

   **Note:** If needed, fields may be duplicated by placing them in multiple folders, but any given folder may contain a field only once.

7. Select the Save or Save As icon to save the Business View as a Business View Master File.

   When you use the Save As option and you are working with FOCUS files, you will need to specify a DATASET in the Master File that points to the data file.

   If you use the Save option, the Business View will be saved inside the current Master File and the Business View will be visible when the Master File is opened in reporting tools.

   **Note:** The Business View Master File may be saved in a different application than the main files.

8. Select Close from the File menu to close to the Synonym Editor.
Reference: Usage Notes for Business Views

- When creating a Business View using a referenced Master File:
  - The detailed information about fields, such as USAGE and ACTUAL formats or indexes remain in the referenced Master File.
  - All information about Cluster Master Files remain in the referenced Master File.
  - DBA attributes specified in the referenced Master File are respected by the Business Views.
- When a Master File contains more than one field with the same name, as can occur when files are joined, the BELONGS_TO_SEGMENT attribute identifies which instance of the field name is being referenced in the Business View.
- Folders can be empty for organizational purposes. For example, Region can have empty folders called North, South, East, and West.
- You can issue an SQL SELECT command against a Business View. However, a Direct SQL Passthru request is not supported against a Business View.
- Business Views support alternate file views and fully qualified field names.
- The SEG. operator against a Business View folder displays all of the fields in that folder, not all of the fields in the real segment.
- Requests against a Business View cannot reference any fields or segments not in the Business View.
- All HOLD formats are supported against a Business View.
- All adapters for non-FOCUS data sources support retrieval requests against a Business View.
- Business Views are not supported with data source maintenance commands, such as Maintain or REBUILD.
- The referenced Master File or the Master File currently being used to create the Business View, may contain Defines, Computes, Filters, and other fields for use in the Business View.
**Reference: Using a Business View Master File**

When you use the Business View Master File with WebFOCUS tools and reports, the field formats, descriptions, and titles will be retrieved from the original Master File, unless they are customized and a title and description is available through the Business View.

You may access the Business View Master Files from all development areas of Developer Studio.

**In the Projects, Data Servers, or Repository area:**

The Table List shows all available Master Files, including the Business Views that are available. The Description column shows a description from the Master File or the Business View file.

The following image is an example of a Business View Master File in the WebFOCUS Table List, that appears when creating a report in the Data Servers area.

![WebFOCUS Table List](image)

This is also available in the Projects area, however, the Table List does not show remarks in the Projects area.
**In Report Painter:**

When using a Business View Master File in Report Painter, only fields from the Business View are shown in the Fields list.

The following image is an example of a Business View Master File in Report Painter.

![Image of Business View Master File in Report Painter](image)

**In InfoAssist:**

When using a Business View Master File in InfoAssist, only fields from the Business View are shown in the Fields list.
Adding Virtual Columns (DEFINE) in a Synonym

You may create a DEFINE field as a custom field in the Synonym Editor. A custom field can be used in a request as though it is a real data source field. Virtual columns (DEFINE fields) are available when the data source is used for reporting.

A virtual column can contain an expression, a constant, or a column name.

- If the virtual column is a complex expression, you can create the expression with the Virtual Column Calculator or just type it into the Expression field.
- If the virtual column is a simple expression, such as a constant value, you can type the value in the Expression field.
Virtual columns are designated by the following icon:

After creating a virtual column, you can test it by right-clicking the synonym and selecting Sample Data. Sample data appears in a separate dialog box.

**Procedure: How to Create a Virtual Column in a Synonym**

To create a virtual column in a synonym:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   The Synonym Editor opens.

2. Right-click a segment (or column), select Insert, and click Define.
   The Define Calculator opens, as shown in the following image.

3. From the Define Calculator, type a name for the column in the Name input field, or use the default define name.
4. You may enter a descriptive title for the virtual column (DEFINE) in the Title input field.

   **Tip:** From the Synonym Editor, click the browse (...) button at the right of the TITLE and DESCRIPTION value fields to specify multiple language titles.

5. Use the Expression tab and the calculator buttons to build the expression for the virtual column (DEFINE).

   or

   Use the Relational Expression tab to build the expression.

   **a.** From the Relational Expression tab, click the Add New Row button and use the drop-down menus to select the filter Column, Relation, and Type.

   **Note:** Parameters are not supported.

   **b.** Click the browse (...) button at the right of the Value input field.

   The Value Selection dialog box opens, as shown in the following image.
c. Select from the available values and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Relational Expression tab.

The selection is added to the value field.

e. To add another expression double-click a column or variable from the Columns/Variables tab on the right side of the calculator.

The row is added to the Relational Expression tab, where you can create the expression.

f. To delete an expression, select the number or field column of the expression and click the Delete button, or right-click it and select Delete selected row(s). The expression is removed from the Relational Expression tab.

6. You may click the Check expression and Sample Data buttons, located on the top right of the calculator, to verify that the expression is valid and to view sample data for the filter.

7. Click OK to close the calculator and return to the Synonym Editor.

**Note:** You can edit the Define, Title, or Expression directly from the Properties section of the Synonym Editor or you can click the browse (…) button located at the right of the EXPRESSION value field to relaunch the calculator.

8. If no columns from the synonym are used in the expression or have been defined, you can use the WITH option to identify the logical home of the defined calculation. You can also use the WITH option to move the logical home for the virtual column to a lower segment than it would otherwise be assigned (for example, to count instances in a lower segment).

**Tip:** You can click and drag the DEFINE field and move it to a different segment in the Field View tab, which also changes the segment association.

9. Specify the Missing Data options for columns that allow null data. You can allow all missing data.

10. Click Save from the File menu to save the synonym.

11. To close the Synonym Editor, select Close from the File menu or click the control button in the upper-right corner.

For more information about expressions and virtual column (DEFINE) attributes, see Defining Attributes and Creating Expressions for Custom Fields on page 172.
Creating Filters in a Synonym

Filters are created in the Master File through the Synonym Editor and can be used in a Business View file or in reporting tools. You can also use filters to perform other data checking and validation, and sort data based on the conditions that you create.

Filters are created under a specific segment and, by default, they have association with the selected segment. Filters can also be created without segment association.

Procedure: How to Create Filters in a Synonym

1. From the Projects or Data Servers area, double-click a synonym from the Master Files folder, or right-click the synonym and select Edit in Synonym Editor.

   The Synonym Editor opens.

2. Right-click a segment or field, select Insert, and click Filter.

   The Filter Calculator opens, as shown in the following image.

   ![Filter Calculator Image]

3. From the Filter Calculator, type a name for the filter in the Name input field or use the default filter name.
4. The Format field shows a default value of I1.

   **Note:** The Format field cannot be changed. Values for filters return 0 for false and 1 for true.

5. You may enter a descriptive title for the filter in the Title input field.

   **Tip:** From the Properties Pane in the Synonym Editor, click the browse (…) button at the right of the TITLE and DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for the filter.
   or
   Use the Relational Expression tab to build the expression.

   **a.** From the Relational Expression tab, click the Add New Row button and use the drop-down lists to select the filter Column, Relation, and Type.

   **Note:** Parameters are not supported with Master File Filters.

   **b.** Click the browse (…) button at the right of the Value input field.
The Value Selection dialog box opens, as shown in the following image.

![Value Selection Dialog Box]

**c.** Select from the available values and use the arrows to add or remove values.

**d.** Click **OK** to close the Value Selection dialog box and return to the Relational Expression tab.
The expression is added to the value field.

![Filter Calculator](image)

**e.** To add another filter, double-click a column or variable from the Fields/Variables section on the right side of the Filter Calculator.

The filter is added to the Relational Expression tab where you can add the expression value.

**f.** To delete an expression, select the number or field column of the expression and click the Delete button, or right-click it and select Delete selected row(s).

The expression is removed from the Relational Expression tab.

7. You may click the Check expression and Sample Data buttons, located on the top right of the Filter Calculator to verify that the expression is valid and to view sample data for the filter.

8. Click OK to close the Filter Calculator and return to the Synonym Editor.

**Note:** To edit the Filter, Title, or Expression, you may do so directly from the Properties Pane in the Synonym Editor or you may click the browse (...) button at the right of the EXPRESSION value field to relaunch the Filter Calculator.
9. To create a Filter without segment association, use the WITH drop-down list to select a blank segment.

Filters are created under a specific segment and by default they have association with the selected segment. Filters can also be created without segment association.

![Screenshot showing the Synonym Editor with filter options]

**Note:** If you are using a field that appears in multiple segments, the WITH segment associated should be the lowest level segment or it should be left empty to prevent errors.

In addition, if no fields from the synonym are used in the expression or have not been computed, you can use the WITH option to identify the logical home of the filter calculation. You can also use the WITH option to move the logical home for the filter field to a lower segment than it would otherwise be assigned (for example, to count instances in a lower segment).

10. Click Save from the File menu to save the synonym.

   The filter is saved as part of the synonym.

11. To close the Synonym Editor, select Close from the File menu or click the control button in the upper-right corner.

**Adding Computed Fields (COMPUTE) in a Synonym**

You may create a Computed field as a custom field in the Synonym Editor. The procedure for adding a custom field is similar to the procedure used to add a Defined field. The Computed field is identified as the Master File Computed field and is differentiated from the Defined fields and the other Computed fields.

**Note:** Computed fields from the Master File appear in the Report Painter fields list.
Procedure: How to Create a Computed Field in the Synonym Editor

To create a computed column in a synonym:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   The Synonym Editor opens.

2. Right-click a segment (or column), select Insert, and click Compute.
   The Compute Calculator opens.

3. From the Compute Calculator, type a name for the column in the Column input field or use the default compute name.

4. You may enter a descriptive title for the computed field (COMPUTE) in the Title input field.

   **Tip:** From the Synonym Editor, click the browse (…) button at the right of the TITLE and DESCRIPTION value fields to specify multiple language titles.

5. Use the Expression tab and the calculator buttons to build the expression for the computed field (COMPUTE).
Use the Relational Expression tab to build the expression.

a. From the Relational Expression tab, click the Add New Row button and use the drop-down lists to select the filter Column, Relation, and Type.

Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

c. Select from the available values and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Relational Expression tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables tab on the right side of the Compute Calculator.

The filter is added to the Relational Expression tab, where you can add the expression value.

f. To delete an expression, select the number or field column of the expression and click the Delete button, or right-click it and select Delete selected row(s). The expression is removed from the Relational Expression tab.

6. You may click the Check expression and Sample Data buttons, located on the top right of the Compute Calculator, to verify that the expression is valid and to view sample data for the filter.

7. Click OK to close the Compute Calculator and return to the Synonym Editor.

Note: To edit the Compute, Title, or Expression, you may do so directly from the Properties section of the Synonym Editor or you may click the browse (...) button at the right of the EXPRESSION value field to relaunch the Compute Calculator.

8. Specify the Missing Data options for columns that allow null data. You can allow all missing data.

9. Click Save from the File menu to save the synonym.

10. To close the Synonym Editor, select Close from the File menu or click the control button in the upper-right corner.

For more information about expressions and COMPUTE attributes, see Defining Attributes and Creating Expressions for Custom Fields on page 172.
Storing the Number of Repetitions of a Repeating Field in a Virtual Field

The OCCURS attribute in a Master File describes repeating fields or groups of fields in a non-FOCUS data source. The repeating group of fields is described as a descendent segment in the Master File, and the OCCURS attribute for that segment specifies how to determine the number of repetitions.

The number of repetitions does not have to be the same for every record instance. Sometimes, the number of repetitions can be derived from a field in the data source. In that case, you can create a virtual field in the Master File that indicates the number of repetitions for each record and use that virtual field as the value of the OCCURS attribute.

**Syntax:**

*How to Specify an OCCURS Segment Using a Virtual Field*

```
SEGNAME = parent, SEGTYPE = segtype,$
  .
  .
  DEFINE definefield/I = expression;
SEGNAME = osegname, SEGTYPE=S0, PARENT = parent,
  OCCURS = definefield ,$
FIELDNAME = rfield, ALIAS = ralias,
  USAGE = rufmt, ACTUAL = rafmt,$
  .
  .
  [FIELDNAME = orderfield, ALIAS = ORDER,
    USAGE = In, ACTUAL = I4,]$}
```

where:

*parent*  
Is the name of the parent segment.

*segtype*  
Is the SEGTYPE of the parent segment.

*definefield*  
Is the virtual field that indicates the number of repetitions of the repeating field or group of fields. This field must be defined in a segment that is an ancestor of the segment containing the repeating fields.

*n*  
Is the format of the virtual field that describes the number of repetitions. It must be an integer format.
**expression**
Is a valid expression that derives the number of repetitions for each record instance.

**osegname**
Is the name of the descendent OCCURS segment.

**rfield**
Is the name of a repeating field in the OCCURS segment.

**ralias**
Is the alias of a repeating field in the OCCURS segment.

**rufmt**
Is the display format for a repeating field in the OCCURS segment.

**rafmt**
Is the actual format for a repeating field in the OCCURS segment.

**orderfield**
Is the name of an internal counter field that you can specify as the last field in the OCCURS segment. The ORDER field associates a sequence number with each occurrence and is useful when the order of the repeating data is significant. For example, the values may represent monthly or quarterly data, but the record itself may not explicitly specify the month or quarter to which the data applies. The USAGE format must be integer and the ACTUAL format is I4.

**Reference:** Usage Notes for Using a Virtual Field With OCCURS
The virtual field used as the OCCURS value cannot be redefined inside or outside of the Master File.

**Example:** Using a Virtual Field With an OCCURS Segment
The following request against the EMPLOYEE data source creates a fixed-format sequential file with a repeating field. The request:

- Counts the number of FICA deductions for each employee.
- Creates a calculated field that contains the length of all FICA deduction fields for each employee.
- Creates a HOLD file in which each record contains the calculated length of the deduction fields for the employee, the identifying information for the employee, and all FICA deductions for the employee.
Note that the number of deductions will vary for each employee. The part of the record that contains the deductions will constitute the OCCURS segment. The number of repetitions will have to be derived from the length field created in the TABLE request.

The procedure to create the file with the repeating deduction field follows:

```
DEFINE FILE EMPLOYEE
  CTR/I5 WITH DED_AMT = IF EMP_ID NE LAST EMP_ID THEN 1 ELSE LAST CTR + 1;
END
TABLE FILE EMPLOYEE
  SUM CNT.DED_AMT NOPRINT EMP_ID LAST_NAME FIRST_NAME CURR_SAL
  COMPUTE DEDLEN/I5 = 12 * CNT.DED_AMT;
  BY EMP_ID NOPRINT
  SUM DED_AMT
  BY EMP_ID NOPRINT
  ACROSS CTR NOPRINT
  WHERE DED_CODE EQ 'FICA'
  ON TABLE SET HOLDLIST PRINTONLY
  ON TABLE HOLD AS OCCURS1 FORMAT ALPHA
END
```

The OCCURS1 file has one record per employee with a variable number of DED_AMT fields. The total length of the number of actual instances of DED_AMT is stored in the field named DEDLEN. The Master File generated by the HOLD command lists 10 DED_AMT fields:

```
FILENAME=OCCURS1, SUFFIX=FIX, $
SEGMENT=OCCURS1, SEGTYPE=S0, $
  FIELDNAME=EMP_ID, ALIAS=E01, USAGE=A9, ACTUAL=A09, $
  FIELDNAME=LAST_NAME, ALIAS=E02, USAGE=A15, ACTUAL=A15, $
  FIELDNAME=FIRST_NAME, ALIAS=E03, USAGE=A10, ACTUAL=A10, $
  FIELDNAME=CURR_SAL, ALIAS=E04, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DEDLEN, ALIAS=E05, USAGE=I5, ACTUAL=A05, $
  FIELDNAME=DED_AMT, ALIAS=E06, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E07, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E08, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E09, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E10, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E11, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E12, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E13, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E14, USAGE=D12.2M, ACTUAL=A12, $
  FIELDNAME=DED_AMT, ALIAS=E15, USAGE=D12.2M, ACTUAL=A12, $
```
You can edit the Master File to describe these repeating DED_AMT fields with an OCCURS segment. The DEFINE field named NUMOCC derives the number of occurrences from the DEDLEN field. The ORDER field is not actually in the file. It is an internal counter populated by WebFOCUS:

```
FILENAME=OCCURS1, SUFFIX=FIX, $
SEGMENT=OCCURS1, SEGTYPE=S0, $
    FIELDNAME=EMP_ID, ALIAS=E01, USAGE=A9, ACTUAL=A09, $
    FIELDNAME=LAST_NAME, ALIAS=E02, USAGE=A15, ACTUAL=A15, $
    FIELDNAME=FIRST_NAME, ALIAS=E03, USAGE=A10, ACTUAL=A10, $
    FIELDNAME=CURR_SAL, ALIAS=E04, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DEDLEN, ALIAS=E05, USAGE=I5, ACTUAL=A05, $
DEFINE NUMOCC/I2 = DEDLEN/12;,$
SEGNAME=DEDUCTION, SEGTYPE=S0, PARENT=OCCURS1, OCCURS=NUMOCC,$
    FIELDNAME=DED_AMT, ALIAS=E06, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=ORDER, ALIAS=ORDER, USAGE=I2, ACTUAL=I4,$
```

The following request uses the ORDER field to select and print the first occurrence of the repeating field for each employee. Since every employee has at least one deduction, every employee is represented on the report output:

```
TABLE FILE OCCURS1
    PRINT NUMOCC LAST_NAME CURR_SAL DED_AMT
    WHERE ORDER EQ 1
END
```

The output is:

```
NUMOCC  LAST_NAME               CURR_SAL          DED_AMT
------  ---------               --------          -------
10  STEVENS               $11,000.00           $64.17
  8  SMITH                 $13,200.00          $100.10
  4  JONES                 $18,480.00          $247.94
  8  SMITH                  $9,500.00           $60.96
  1  BANNING               $29,700.00          $519.75
  8  IRVING                $26,862.00          $626.78
  4  ROMANS                $21,120.00          $317.62
  1  MCCOY                 $18,480.00           $161.70
  5  BLACKWOOD             $21,780.00          $444.67
  7  MCKNIGHT              $16,100.00          $187.88
  4  GREENSPAN              $9,000.00           $52.50
 10  CROSS                 $27,062.00          $631.40
```
If you print the tenth occurrence of the repeating field, only two employees are displayed on the report output:

```plaintext
TABLE FILE OCCURS1
  PRINT NUMOCC LAST_NAME CURR_SAL DED_AMT
  WHERE ORDER EQ 10
END
```

The output is:

<table>
<thead>
<tr>
<th>NUMOCC</th>
<th>LAST_NAME</th>
<th>CURR_SAL</th>
<th>DED_AMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>STEVENS</td>
<td>$11,000.00</td>
<td>$58.33</td>
</tr>
<tr>
<td>10</td>
<td>CROSS</td>
<td>$27,062.00</td>
<td>$526.20</td>
</tr>
</tbody>
</table>

**Defining Attributes and Creating Expressions for Custom Fields**

A custom field is a field whose value is not stored in the data source but can be calculated from the data that is there. You can create a custom field in your synonym by adding a virtual column (DEFINE), Master File filter (FILTER), and a Computed Field (COMPUTE). The fields are available whenever you access the corresponding data source in a reporting tool.

You can define attribute values and create expressions for custom fields by using the Synonym Editor.
Reference: Custom Field Attributes

The following attributes may be available for custom fields (DEFINE, FILTER, and COMPUTE) in the Synonym Editor.

**Note:** The attributes available depend on the type of synonym and the type of custom field selected. The following image is an example of an SQL data source with a virtual column (DEFINE) selected.

Custom fields (DEFINE, FILTER, COMPUTE) typically have the following attributes:

**General**

**DEFINE**

Is the name of the virtual column.

**Note:** This attribute only appears when a virtual column (DEFINE) is selected.
FILTER
Is the name of the Master File Filter field.

**Note:** This attribute only appears when a virtual filter field is selected.

COMPUTE
Is the name of the computed field.

**Note:** This attribute only appears when a virtual computed field is selected.

EXPRESSION
Is the expression that creates the virtual column.

TITLE
Supplies a title to replace the column name that is normally used in reports and enables you to specify multiple language titles for the virtual column.

FORMAT
Describes the data type and format for the virtual column.

**Note:** This attribute only appears for DEFINE and COMPUTE custom fields.

Allow Missing Data
Allows missing data. If not, the transaction value is supplied.

**Note:** This attribute only appears for DEFINE and COMPUTE custom fields.

All
Allows all missing data. If not, the transaction value is supplied.

**Note:** This attribute only appears for DEFINE and COMPUTE custom fields.

Miscellaneous

REDEFINES
A DEFINE expression may not contain qualified field names. REDEFINES enables you to redefine or recompute a column whose name exists in more than one segment.
WITH

If no columns from the synonym are used in the expression or have been defined, you can use the WITH option to identify the logical home of the defined calculation. You can also use the WITH option to move the logical home for the virtual column to a lower segment than it would otherwise be assigned (for example, to count instances in a lower segment).

Note: This attribute only appears for DEFINE and FILTER custom fields.

DESCRIPTION

Contains a description or comments about the virtual column.

WITHIN

Contains the name of a field to be included in a dimension.

These WITHIN statements are added to the synonym through the Dimension Builder to OLAP-enable FOCUS files and relational tables. This enables you to perform OLAP analysis using the OLAP Control Panel or to use it with the Financial Report Painter.

Note: This attribute only appears for DEFINE and FILTER custom fields.

USE_STYLE

Is the name of the stylesheet applied to a field.

Note: The attributes available depend on the type of synonym.
Reference: Calculators for Custom Fields

To launch the Define Calculator, Filter Calculator, or Compute Calculator, click the browse (...) button at the right of the EXPRESSION value field in the Properties section of the Synonym Editor.

The selected calculator opens, depending on the type of custom field that you are creating.

The calculator has the following fields and options:

**Name**
Is the name of the object being created (virtual field (DEFINE), filter, computed field).

**Format**
Is the field format.
**Expression tab**

Location for typing an expression. You can add data source fields from the Columns/Variables tab, functions from the Functions tab, and numbers and operators from the calculator as you type.

**Relational Expression tab**

Displays the expression building window from which you can add and delete columns, choose the relation and type, and select values for your filter.

**Fields/Variables tab**

Displays a hierarchical list of available source columns and System Variable folders that you can use in creating an expression.

**Functions tab**

A function is a program that returns a value. This tab lists the built-in functions that you can use to derive the value of a temporary field.

**Function Assist button**

Enables you to specify parameters for the function through a dialog box when creating or editing a transformation.

**Calculator buttons**

Enables you to insert numbers and operators.
The following operators are available:

| (single concatenation bar)

Concatenates two values, retaining any trailing blanks after the first one. For example, if FIRST_NAME and LAST_NAME were both in A15 format, the expression

\[
\text{FULL\_NAME} = \text{FIRST\_NAME} \mid \text{LAST\_NAME}
\]

would produce a column like the following:

| MICHAEL | SMITHSON |
| ANE     | JONES    |
| .       | .        |

|| (double concatenation bar)

Concatenates two values, suppressing any trailing blanks in the first. For example, to construct the full name and insert a comma (,), the syntax

\[
\text{FULL\_NAME} = \text{LAST\_NAME} || (', ' \mid \text{FIRST\_NAME})
\]

would produce a column like the following:

| SMITHSON, MICHAEL |
| JONES, JANE       |
| .                 |

The concatenation in the parentheses is done first (preserving the blank space after the comma), and the result is then concatenated to LAST_NAME, suppressing the trailing blanks of LAST_NAME.

IF

Establishes a conditional test.

THEN

Specifies the action to perform if the result of a conditional test is TRUE.

ELSE

Specifies the action to perform if the result of a conditional test is FALSE.

LT

Returns the value TRUE if the value on the left is less than the value on the right.
**NOT**
Returns the value TRUE if the operand is false.

**LE**
Returns the value TRUE if the value on the left is less than or equal to the value on the right.

**EQ**
Returns the value TRUE if the value on the left is equal to the value on the right.

**AND**
Returns the value TRUE if both operands are true.

**GT**
Returns the value TRUE if the value on the left is greater than the value on the right.

**GE**
Returns the value TRUE if the value on the left is greater than or equal to the value on the right.

**NE**
Returns the value TRUE if the value on the left is not equal to the value on the right.

**OR**
Returns the value TRUE if either operand is true.

****
Raises a value to the specified power.

**( )**
Adds parentheses.

```
```
Inserts two single quotation marks. Enter alphanumeric test values between the quotation marks.

**a->A**
Converts selected text to uppercase.

**A->a**
Converts selected text to lowercase.
Adding Group Fields in a Synonym

For data sources that support groups, you can assign a unique name to multiple fields to create a group field. A group field is created by two or more alphanumeric fields, physically next to each other. A group field provides an efficient means for grouping similar or logically connected fields that will be accessed as a single unit, but do not warrant a separate segment.

Note: In the Maintain environment, group fields are supported in a Master File as long as they are not group keys. That is, groups that are actual fields, as supported by VSAM. If you create a group field in the Maintain environment, the group will not be visible, only the fields that make up the group will be visible.
**Procedure: How to Add a Group Field to a Segment**

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
   The Synonym Editor opens.

2. Right-click a segment (or column), select *Insert*, and click *Group*.
   
   **Note:** The group option may not be available for some data sources.

   A group is added to the synonym and its attributes and values appear on the right.

   ![Synonym Editor with added group](image)

3. Type a name for the group in the *GROUP* field.

4. Select the USAGE Type value for the group. Specify the length, the decimal places (if applicable) and any display options for the group.

5. Select the *I - Index* check box if you want the group to be indexed.

6. Select the ACCESS_PROPERTY values to specify access options for the group data.

7. Optionally, you can specify the TITLE and DESCRIPTION display options.

8. Click *Save* from the File menu to save the synonym.

9. To close the Synonym Editor, select *Close* from the File menu or click the control button in the upper-right corner.

   **Note:** When you add a group, a field is automatically added to the group.
**Procedure: How to Add a New Field to a Group Field**

1. Right-click the group field to which you want to add a new field, select *Insert*, and click *Field*.

   A field is added to the group and its attributes and values appear on the right, as shown in the following image.

   ![Image of Adding a New Field](image-url)

   2. Supply the required information for the group field. For more information about field attributes, see *Viewing and Editing Synonym Attributes* on page 97.

**Procedure: How to Add an Existing Field to a Group Field**

1. Click the field you want to add to the group field.

2. While holding the left mouse button down, drag the field and drop it on the group field name.

   The field is added to the group field.
Procedure: **How to Delete a Group Field From a Segment**

1. Right-click the group and select *Delete*.

   A confirmation appears stating that all columns (fields) within the group will be deleted.

   ![Confirm](image)

2. Click *Yes* to delete the group and move the fields (within the group) under the root segment of the synonym.

   Click *No* to delete the group and all of the fields within the group.

   Click *Cancel* to close the Confirm Delete dialog box and return to the Synonym Editor.

Procedure: **How to Delete a Field From a Group Field**

Right-click the field, then select *Delete*. 
**Reference: Group Field Attributes**

Group fields in a synonym can have the following attributes:

### General

**GROUP**

Is the name of the group.

**ALIAS**

Assigns an alternative name for a group.

If you create a report, the group name appears as a column heading unless you have specified an alternate title for the group. Aliases cannot be used as column titles.

**TITLE**

Supplies a title to replace the group name that is normally used in reports and enables you to specify multiple language titles for the group.

**USAGE**

Contains the format for the group field. Since the group field is made by concatenating together several other fields, the Synonym Editor determines what this format needs to be. For example, if the group field has two alphanumeric fields in it, each 20 characters long (A20), then the group field must be alphanumeric and 40 characters long (A40). The group field is always alphanumeric, regardless of the fields that make it up.
**Miscellaneous**

**DESCRIPTION**

Contains a description or comments about the group. The description displays in Field lists and on the status bar.

Field descriptions also appear as bubble help in OLAP-enabled reports. If you do not include a description, bubble help shows the field name (column title).

For information on displaying bubble help in OLAP-enabled reports, see the *Creating Reporting Applications With Developer Studio* manual.

**FIELDTYPE**

Identifies an indexed group. You can index the values of a field to enhance data retrieval performance. To do so, select the Index check box when you add a field and before you add the data. An index is an internally stored and maintained table of data values and locations that enhance the performance of data retrieval. A Master File can have several associated indexes, but the combined total of indices and segments cannot exceed 64.

*Note:* FIELDTYPE=R indicates a read-only column. This setting is useful for columns that are automatically assigned a value by the RDBMS.

*Tip:* You can turn on the index after adding data to a field, however, you will have to use the Rebuild Index option to create the index.

**ACCESSPROPERTY**

Specifies access options for the column data.

INTERNAL defines a column that does not appear in sample data or in the list of available columns. Restricts the field from showing in any of the Field Lists in the reporting tools.

NEED_VALUE defines a column that requires a value to access the data. Indicates that a selection is needed in the report request (WHERE condition).

Select By defines a column by value, range, or multivalues:

- If Value is checked, only one value should be defined for selection in the report request.
- If Range is checked, a range selection should be defined in the report request.
- If Multivalues is checked, multiple values are allowed for selection in the report request.

**USESTYLE**

Is the name of the stylesheet applied to a group.
Applying Database Administrator Security

You can secure Master Files on a file-by-file basis. For each data source, security can be maintained at two different levels.

- **Database Administrator Level.** You specify the Database Administrator (DBA) password for the data source. The DBA has unlimited access to the Master File and data source and can set up or change security restrictions for individual users. Only the Database Administrator can encrypt (scramble) or decrypt (unscramble) a data source. For more information, see *Encrypting and Decrypting a Master File* on page 194.

- **User Level.** You specify the DBA and user passwords for the data source. The user password represents a user who has access to that data source. When you specify a user password, you must also set at least the type of file access: read, write, read/write, or update. Security for each user can be further limited by restricting access to segments, fields, or field values. For more information, see *Restricting Access to Segments, Fields, Field Values, and Noprint* on page 191. Once a user password has been established, you can apply the same restrictions to multiple users. For more information, see *Applying Security Restrictions for Multiple Users* on page 193.

**Note:** You cannot specify a Database Administrator (DBA) password during the Create Synonym process. You must use the Synonym Editor.

When security is specified, the Database Administrator or user, must enter a password to get access to the data source. When the DBA or user no longer needs access to the data source, you can delete their security.

Before adding any type of security to a data source, the Database Administrator must be aware of certain DBA guidelines. See *DBA Guidelines* on page 188.
**Procedure: How to Set Up Security for the Database Administrator**

1. In the Synonym Editor, click **DBA** from the Tools menu or click the **DBA** button from the Synonym toolbar.

   The DBA pane opens in the workspace, as shown in the following image.  

   ![Synonym Editor Image](image)

2. Right-click the file name in the DBA window and select **Insert**, then **DBA**.

   A default DBA password will be created for the Master File. You can change this value, delete it, add users to specify file restrictions, or add file names to specify data source-specific restrictions to the current data source. You can also specify a separate DBA file that contains DBA security restrictions.

   **Note:** When the password is created and the cursor is in that field, you can right-click and use the edit options to undo, select all, cut, copy, paste, or delete the password.

**Procedure: How to Set Up Security for the User**

1. In the DBA pane, right-click the DBA icon to insert user restrictions or specify a DBA file.

2. Once you add a user you can continue to insert file access restrictions by right-clicking the user field and selecting **Insert**.

3. Select the type of access: **Read**, **Write**, **Read/Write**, or **Update**.

4. Specify the type of restriction for each option: **Restriction to Field**, **Value**, **Segment**, **Noprint**, or **Same Restriction**.
Note: The Same Restriction option is activated when there are multiple users.

5. Click OK to save the Master File with the user password and restrictions.

**Reference: DBA Guidelines**

You can ensure that the security restrictions you place on Master Files are correct by adhering to the following guidelines:

- Every file with access limits must have a DBA password.

- No segment, field, or field value restrictions may be specified at the Database Administrator level. The Database Administrator should have unlimited access to the data source and all cross-referenced data sources.

- Once security restrictions have been applied, the Database Administrator should conduct thorough testing of every restriction before the data source is used. It is particularly important to check field values to make sure they do not contain errors. If they are in error, user access to the field data will be unnecessarily restricted.

- All groups of cross-referenced data sources must have the same security restrictions.

- You must have a DBA password to encrypt and decrypt or restrict existing data sources.

- The Database Administrator can change any type of security restriction.

- Access levels affect the fields users can access. The Database Administrator must consider what commands each user will need. If a user does not have access rights, that user will receive a message.
Reference: DBA Pane

The following options are available from the DBA pane when the DBA password is selected.

**DBA password**

By default, the DBA password is the same as the user ID used to connect to the reporting server. Using the Rename option from the DBA password Context menu, you may enter a different password of up to sixty-four characters. This is the password of the DBA who will be creating and maintaining the current data source. The DBA has full access to the data source and the corresponding Master File, controls the access rights of other users, and has encryption privileges. See *Encrypting and Decrypting a Master File* on page 194.

**DBAFILE**

Select the name of the Master File that contains your DBA security restrictions. Other Master Files can use the DBA security restrictions in this Master File.

**Insert Filename**

Enter the name of the Master File to which user security will be applied. This option is used to add data source-specific restrictions to the current data source. It includes a FILENAME attribute for the selected Master File. The FILENAME attribute in the referenced Master File must be the same as the FILENAME attribute in the DBA section of the current data source.

**Insert Users**

Enter the names (up to sixty-four characters) of users whose access rights will be granted for the current data source.
**File Access**

For user access, select one of the following options:

- Choose *Read* for full viewing rights.
- Choose *WRITE* to permit additions or changes to the data source.
- Choose *READ/WRITE* for both of the above.
- Choose *UPDATE* to permit changes to field values.

**Restrictions: Segment, Field, Value, Noprint, Same**

When the file access is selected, continue to select the type of restriction you wish to apply.

- Choose *Segment* to grant access to all or individual segments.
- Choose *Field* to grant access to all or individual fields.
- Choose *Value* to limit access to values that meet a test condition. See *Restricting Access to Segments, Fields, Field Values, and Noprint* on page 191.
- Choose *Noprint* to specify fields you do not want to display in a report.
- Choose *Same* to apply the same restrictions as other users that are already set up.

**Access Restrictions**

- **User.** Is the user name written to the Master File.
- **Name.** Is the name of the Master File component selected (for example, the segment or field name).
- **Access.** Is the type of access restriction.
- **Restrict.** Is an option for File access restriction.
- **Value.** Is the value for which to restrict access.

**Selecting the Type of Access**

When you assign a user password, the *type of file access* and *access restrictions* options are available. You must specify at least the type of access the user is permitted to have for the data source. The type of file access can be specified in the File Access group on the DBA pane. In this group, there are four file access options:

- **Read.** Allows the user only to read (to view) the data source.
- **WRITE.** Allows the user only to write (add or to make changes) to the data source.
- **READ/WRITE.** Allows the user to read and write to the data source.
- **UPDATE.** Allows the user to update (make changes to) existing field values.

The type of file access determines what a user can do to the entire data source:

- If you specify only the type of file access, the user will have the specified access to the entire data source.
- If you want to impose additional limitations you can restrict access to segments, fields, and field values. See *Restricting Access to Segments, Fields, Field Values, and Noprint* on page 191.

**Restricting Access to Segments, Fields, Field Values, and Noprint**

You can restrict access to segments, fields, field values, and Noprint fields in a Master File by specifying access restrictions for a user. When you specify what is to be restricted, such as segment, field, or value, you can then specify the type of access that will be restricted.

Right-click the file access restriction and select the **Segment**, **Field**, or **Value**, or **Noprint** option from the Context menu.

- **Segment.** You specify the type of access for individual segments, as shown in the following image.

![Image of segment access restrictions](image-url)
The following image illustrates how a user can change a segment name.

- **Field.** You specify the type of access for individual fields.
- **Value.** You specify the type of access (read or write) and the test condition. The user is restricted to using only those values that satisfy the test condition.

The following image illustrates how to change a field name used in a value field.
The following image illustrates how to create a condition. This dialog box is presented after pressing the ellipsis next to the value field.

- **Noprint.** You can also specify not to display the data in that field using Noprint. If you specify Noprint for a field, the data will appear as blanks for alphanumeric format or zeros for numeric format whenever the user tries to retrieve it.

**Applying Security Restrictions for Multiple Users**

You can specify restrictions for one user and apply the same restrictions to other users. This helps when you want to set the same restrictions for a group of users.

**Procedure:** How to Apply Previously Defined Restrictions to Another User

1. In the DBA pane, right-click the DBA password and select *Insert*, then *User*.
2. Right-click the newly added user and select *Insert* to specify the desired type of access restriction you would like to apply.
   
   Available access types are Write Access, Read/Write Access, and Update Access.
3. Right-click an access type and select *Insert*, then *Same Restriction*. 
4. Click the arrow on the drop-down combo box next to the NAME attribute in the Properties pane, and then select the user with the security restrictions that would apply to the new user.

Security restrictions from the user selected in the drop-down combo box are applied to the new user. You can apply the security restrictions to other users by repeating steps 1 to 4.

**Note:** You must have created at least one user security restriction to apply security restrictions to multiple users.

### Deleting a DBA or User Password

You can delete a DBA password or security for a user when it is no longer needed.

**Procedure:** **How to Delete a User Password**

1. On the DBA pane, select the user password you wish to delete.
2. Right-click and select *Delete* or press *Delete* on the keyboard.

If you delete the user based upon whom you have assigned security restrictions for other users, you must reset security restrictions for all users attached to the user you deleted.

**Procedure:** **How to Delete a DBA Password**

Deleting a DBA password will delete all user security for that data source.

On the DBA pane select the DBA password, then right-click and select *Delete* or press *Delete* on the keyboard.

All security information is removed.

### Encrypting and Decrypting a Master File

You may use the Encrypt and Decrypt attributes from the Synonym Editor to scramble and unscramble some or all of the contents of a data source. When you encrypt Master Files, they are secure from unauthorized examination.

Encryption at the data source level scrambles the entire contents of that Master File so it is unreadable. When you encrypt a Master File, you can decrypt it. Decrypting unscrambles the contents to its readable state.
Before you can encrypt or decrypt any Master File, you must specify the DBA password. If you do not specify a DBA password, you will not be able to encrypt or decrypt the file.

**Procedure: How to Encrypt a Master File**

1. In the Synonym Editor, select **DBA** from the Tools menu or click the **DBA** button from the Synonym toolbar.
   
   The DBA pane opens.

2. Create and save the Master File with the DBA password.

3. From the Synonym Editor Field View tab, select a segment from the Master File hierarchy (left pane).
   
   The values for the selected segment appear in the Properties pane on the right.

4. Select the **ENCRYPT** check box.

5. Click **Save** from the File menu to encrypt the Master File.

**Procedure: How to Decrypt a Master File**

1. At the encrypted segment level in the Master File hierarchy, clear the **ENCRYPT** attribute.

2. Click **Save** from the File menu to decrypt the Master File.
Chapter 4

Analyzing Metadata and Procedures

This chapter describes how to analyze procedures using Impact Analysis, and how to view Data Profiling for the columns in a synonym.

In this chapter:

- Analyzing Procedures With the Impact Analysis Tool
- Viewing Data Profiling Characteristics

Analyzing Procedures With the Impact Analysis Tool

You can use the Impact Analysis tool to generate a report that identifies the procedures that access a specific Master File or field within a Master File. This tool helps you analyze the potential impact of modifying or deleting Master Files or fields. The Impact Analysis tool enables you to analyze data, control search criteria, save reports, and interactively open and edit procedures based on search results.

Impact Analysis searches Business Views in addition to FOCUS procedures. This enables you to see if changes in the original Master File will impact fields used in the Business View.

For more information about Business Views, see Creating Business Views on page 148.

The Impact Analysis tool is accessible from the Projects, Data Servers, and Managed Reporting areas of Developer Studio and is supported for Windows, UNIX, and z/OS configurations.

Note: You can launch Impact Analysis from the interface or from within the tools in the Synonym Editor and Business Views. When Impact Analysis is launched from the Synonym Editor or Business Views, it searches files based on the application path of the reporting server. From the interface, it enables you to select applications or folders to be searched.

Procedure: How to View Impact Analysis Results From the Synonym Editor

When you launch Impact Analysis from within the Synonym Editor, it searches files based on the application path of the reporting server.

1. From the Projects or Data Servers area, double-click the Master File or select Edit in Synonym Editor from the File menu.

   The Master File opens to the Tree View tab in the Synonym Editor.
2. Select the Synonym File name, or a column field, then right-click and select Impact Analysis from the context menu, as shown in the following image.

![Impact Analysis from context menu](image)

**Note:** Impact Analysis is also available from the Dimension Builder pane.

The Impact Analysis results are displayed in a report spreadsheet.

3. You may use the results toolbar to view server messages, print the report, copy data as text, and export the report.

![Impact Analysis results spreadsheet](image)

4. Click Save from the File menu to save the Impact Analysis results.

5. Click Close from the File menu to close the Impact Analysis results window and return to the Synonym Editor.

**Procedure:** How to Use the Impact Analysis Tool From the Interface

1. From the Projects or Data Servers area, highlight the Master File folder, select a Master File, and select Impact Analysis from the File menu.
The Impact Analysis tool opens with the New Report tab displaying the selected (Master) File Name and default Search Paths.

2. To search for all procedures that access a specific Master File or field, perform one of the following:
   - **Selected Master File.** The Master File you selected when opening the tool will be searched by default. Proceed to step 3.
   - **Different Master File.** Click the ellipsis button (...) to the right of the File Name search field and select a different Master File in the Open dialog box that opens.
   - **Single Field Within a Master File.** After you select the desired Master File, click the ellipsis button (...) to the right of the Field Name search field and double-click a field name in the Master File context menu.

3. Optionally, to search for procedures in directory paths not listed by default in the Search Paths pane, add more search paths by clicking the folder icon above the Search Paths area and selecting one or more folders in the Browse for Folder dialog box that opens.
   - **Note:** You can also delete search paths by highlighting a search path and clicking the **Delete** icon above the Search Paths area.

4. Click **Analyze** to display a report in the Impact Analysis Result pane.
The following image shows the New Report tab of the Impact Analysis dialog box populated with File Name search criteria, multiple Search Paths, and a report displayed in the Impact Analysis Result pane.

You have options to edit procedures, print the report, delete an item in the report, and export a report.

Exported reports are XML-formatted, have an .IAR extension, and are saved in the following default directory (unless you specify a different location):
5. Click the Saved Reports tab to access all previously created reports.

All Impact Analysis reports are automatically saved in the following XML-formatted file:

drive:\ibi\DevStudioreleasenumber\bin\IARepository.xml

Information is appended to this file as new analysis reports are performed. You have options to view reports, import previously exported reports, and delete reports.

Viewing Data Profiling Characteristics

Data Profiling provides data characteristics for the columns in a synonym. You can display the characteristics for all the columns in a synonym or segment, or for an individual column.

**Note:** Data Profiling is not available if your adapter is not configured correctly. For more information about configuring the adapter, see Accessing Data and Creating Synonyms on page 19.

For alphanumeric columns, Data Profiling provides the segment, format, count of distinct values, total count, patterns count, maximum, minimum, average length, minimum and maximum values, and number of nulls. Patterns count shows the number of patterns found in each alphanumeric column.

For numeric columns, Data Profiling provides the segment, format, count of distinct values, total count, maximum, minimum, average values, and number of nulls.

Data Profiling for an individual column provides access to Statistics, Patterns, Values, and Outliers reports.

Data Profiling a Synonym or Segment

Data Profiling provides information on all the columns in a synonym or segment. You can also drill down to the Values or Patterns reports for an individual column from a synonym or segment Data Profiling report.

**Procedure:** How to View Data Profiling for a Synonym or Segment

To view the Data Profiling information for a synonym or segment:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.

   The Synonym Editor opens to the Field View tab.
2. Right-click the synonym or segment name and select *Data Profiling*, and then select either *Statistics*, *Count*, *Statistics with parent segment*, *Key Analysis*, *Values*, or *Duplicate Values*, as shown in the following image.

![Data Profiling Menu](image)

The Data Profiling information displays in the workspace.

![Data Profiling Worksheet](image)

You may use the Data Profiling Results toolbar to view server messages, print the report, copy data as text, and export the report.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to drill down to the Values or Patterns reports, respectively.
This is a partial Values report produced by clicking a column name.
The image below is an example of an address column.

For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an a represents any lowercase letter. All printable special characters are represented by themselves, and unprintable characters are represented by an X.

**Data Profiling a Single Column**

Data Profiling for an individual column provides access to four reports:

- **Statistics.** Shows the same information as a Data Profile report for a synonym or segment.

  For alphanumeric columns, the Statistics report provides the segment, format, count of distinct values, total count, patterns count, maximum, minimum, average length, minimum and maximum values, and number of nulls.

  For numeric columns, the Statistics report provides the segment, format, count of distinct values, total count, maximum, minimum, average values, and number of nulls.

- **Patterns.** Only available for alphanumeric columns. This shows patterns of letters, digits, and special characters, as well as counts and their percents.
Values. Shows unique values and their percents.

Values Graph. Displays a graph for alphanumeric field types.

Duplicate Values. Shows identical values.

Outliers. Shows the ten highest and lowest distinct values and their counts.

These reports are available by right-clicking a column in the Synonym Editor and selecting Data Profiling, as shown in the following image.

**Procedure:** How to View Data Profile Statistics

To view the Statistical Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
   The Synonym Editor opens to the Field View tab.

2. Right-click a column and select Statistics from the Data Profiling context menu.
The Statistical Data Profiling information displays in the workspace, as shown in the following image.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to drill down to the Values or Patterns reports, respectively.

**Procedure: How to View Data Profile Patterns**

Data Profile Patterns shows patterns of letters, digits, and special characters, as well as counts and their percentages.

To view the Patterns Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   
   The Synonym Editor opens to the Field View tab.

2. Right-click a column and select Patterns from the Data Profiling context menu.
   
   The Patterns Data Profiling information displays in the workspace.

3. Optionally, you can click a pattern count to display the actual patterns.

   For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an a represents any lowercase letter. All printable special characters are represented by themselves, and unprintable characters are represented by an X.

**Procedure: How to View Data Profile Values**

Data Profile Values shows unique values.

To view the Values Data Profiling information for a single column:
1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   The Synonym Editor opens to the Field View tab.

2. Right-click a column and select Values from the Data Profiling context menu.
   The Values Data Profiling information displays.

Procedure: **How to View the Data Profile Values Graph**

The Data Profile Values Graph shows

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   The Synonym Editor opens to the Field View tab.

2. Right-click a column and select Values Graph from the Data Profiling context menu.
   The Values Graph Data Profiling information displays.

Procedure: **How to View Data Profile Duplicate Values**

Data Profile Duplicate Values shows identical values.

To view the Duplicate Values Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   The Synonym Editor opens to the Field View tab.

2. Right-click a column and select Duplicate Values from the Data Profiling submenu.
   The Duplicate Values Data Profiling information displays.

Procedure: **How to View Data Profile Outliers**

Data Profile Outliers shows the 10 highest and 10 lowest distinct values.

To view the Outliers Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File from the Master Files folder.
   The Synonym Editor opens to the Field View tab.

2. Right-click a column and select Outliers from the Data Profiling context menu.
The Outliers Data Profiling information displays.

**Note:** Outliers produce a maximum of 10 highest and 10 lowest distinct values, if they exist.
If you choose to create a Master File schema before the corresponding FOCUS data source has been created, you will need to create and populate the FOCUS data source before you can use it in reports or other requests. For details about creating a Master File, see Using the Synonym Editor on page 71.

If you modify a Master File, you can rebuild the corresponding data source using the graphical Rebuild utility.

In this chapter:

- Creating a FOCUS Data Source
- Rebuilding a Data Source

Creating a FOCUS Data Source

When you save a Master File, you must also create a corresponding empty data source that will hold the data for the fields defined in the Master File. This data source is saved in the application directory.

After creating the empty data source, you can load data into it with a MODIFY request, or a Maintain request. After you populate the data source, you can use it in conjunction with the Master File in a report request.

Procedure: How to Create a Data Source

1. From the Projects or Data Servers area in Developer Studio, right-click the Master Files folder, select New, and then select Synonym via Synonym Editor.
2. In the New Master File dialog box, type a file name and click Create.
   The Master File opens to the Field View tab in the Synonym Editor.
3. Create and save the synonym.
4. Click Close from the File menu.
5. Click Yes to create an empty FOCUS (.foc) data source file.
FOCUS creates an empty data source (.foc) in the background.

The .foc file is stored in the application directory.

Rebuilding a Data Source

The Rebuild utility provides a number of useful project management utilities. Rebuild enables you to restructure data sources, rebuild indexes, and check the integrity of data sources.

**Note:** You can only use this utility with FOCUS data sources.

**Procedure: How to Use the Rebuild Utility**

To open the Rebuild dialog box:

1. Click *Utilities* from the Command menu and select *Rebuild*.
The Rebuild dialog box opens, as shown in the following image.

```
Rebuild

Options
- Rebuild a disorganized file
- Index a field
- Check the integrity of a file

Filename: [input field]
Selection Criteria: [input field]

OK
Cancel
```

2. Select a Rebuild option.

**Rebuild a disorganized file**

This option can be used to perform the following functions:

- Reoptimize a FOCUS data source after a large amount of data has been added or deleted.
- Select specific segment instances to include in the data source, based on record selection criteria you specify.

**Index a field**

Builds or rebuilds the index for the specified field. Use this option to index an additional field that was not originally specified as an index field or to change the index for a field. See *Rebuilding the Index* on page 212.

**Check the integrity of a file**

Checks the structural integrity of a data source. If FOCUS encounters an error during the check, it displays a message. For more information, see *Checking the Integrity of a Data Source* on page 213.

3. Enter the name of the data source to rebuild. You can either manually name the source, or click the *Browse* button to open a dialog box and select the data source.
4. In the Selection Criteria field, specify the selection criteria for rebuilding a disorganized data source and reorganizing a data source to fit a new Master File. Only data that meets the selection criteria is included in the rebuilt data source.

**Rebuilding a Disorganized File**

This option in the Rebuild dialog box enables you to:

- Restructure and optimize a FOCUS data source after data has been added or deleted.
- Select specific segment instances for inclusion in the data source based on selection criteria you supply. For example, if you specify the following selection criterion:
  
  \[ \text{INVOICE_DATE GT 990101} \]

  FOCUS will omit invoices earlier than 99/01/01 from the rebuilt data source.

**Rebuilding the Index**

When you first create a Master File in the Synonym Editor, you specify the fields that you want indexed. Sometimes, after data is entered, you may need to index an additional field that was not originally specified as an index field.

The first step is to alter the Master File to indicate that the field should be indexed. Altering the Master File does not actually create the index. To do this, you must use the Rebuild utility after you index a field.

**Procedure: How to Index a Field After Data Is Entered**

From the Synonym Editor, select the field to be indexed, and then click the I - Index check box under the FIELDTYPE attribute.

or

Open and edit the Master File as text in the Text Editor. For instructions on indexing a field as text, see the *Describing Data With WebFOCUS Language* manual.

After you index a field you must rebuild the index. See *How to Rebuild the Index* on page 212.

**Procedure: How to Rebuild the Index**

1. In the Rebuild dialog box, select *Index a field*.

2. In the Filename field, type a data source name or click *Browse* and select a data source from the list.

3. In the Field to Index field, type the name of the field you want to index.
To index all the fields designated as index fields in that data source, type an asterisk (*) in the Field to Index box.

4. Click OK.

The Rebuild utility rebuilds the data source, creating an index for all specified fields.

For more information on indexing fields, see the *Describing Data With WebFOCUS Language* manual.

**Checking the Integrity of a Data Source**

It is rare for the structural integrity of a FOCUS data source to be damaged. Structural damage will occasionally occur, however, during a disk drive failure or if an incorrect Master File is used. In this situation, you can check the integrity of the Master File. Checking the integrity of a Master File performs the following essential tasks:

- It checks all pointers in the data source.
- If it encounters an error, it displays a message and attempts to branch around the offending segment or instance. This way, it recovers as much of the data source as possible.

While checking the integrity reports on a good deal of data that would otherwise be lost, it is important to remember that backing up your FOCUS data sources frequently is the best method for preventing data loss.

Checking the Master File integrity will occasionally fail to uncover structural damage. If you have reason to believe that there is damage to your data source, though results from checking the integrity indicates otherwise, there is a second method of checking file integrity. This method uses the `? FILE` and `TABLEF` commands. For more information, see the *Describing Data With WebFOCUS Language* manual.

**Procedure: How to Check the Structural Integrity of a FOCUS Data Source**

In the Rebuild dialog box, select *Check the integrity of a file*.

If the Rebuild utility encounters an error during the check, it logs a message for you. You should then attempt to recover as much of the data source as possible or restore it from a backup.
Index

A

access configuration 23
Access File Text View tab 97
Access Files 14, 19
creating synonyms 19
definition 14
access restrictions 190, 191
adapters 15, 19, 24, 34, 39, 40
configuring 24, 34, 39
configuring in Developer Studio 19, 40
adding a computed field (COMPUTE) in virtual fields 166
adding existing field to group field 182
adding group fields 180
adding new field to group field 182
Administration Console 63
all columns 121, 201, 204
APP PATH (application path) 21
application path (APP PATH) configuring 21
application path (APP PATH) 21
application root directory (APPROOT) 21
applications
show only applications in path 23
Applications node 21
APPLOCK 23
APPROOT (application root directory) 21

B

Business View Master File 155
Business Views 148, 151

C

Check the integrity of a file 213
Client
node class 63
Client communication file 62
CLM Processing 63
CLM Processing node class 63
cluster joins 16, 128
creating 128
cluster node
class 63
column management 79
column/field attribute summary 103
Compute calculator 176
computed fields 165
computed fields in Synonym Editor 165
cookies 66
create new button 32
Create Synonym tool 15, 32, 46
Create Synonym Tool
data access configuration 23
creating a Business View 151
creating Business Views in Developer Studio 148
creating filters 161
creating FOCUS data sources 209
creating logical views 137
creating synonyms 15, 110
creating temporary fields 166
creating virtual columns in Synonym Editor 158
creating virtual fields 166
creating virtual measures with COMPUTES 145
Cube data sources in Synonym Editor 140

Describing Data With Graphical Tools 215
Cube View tab in Synonym Editor 141

D
data access 62
data adapters 39
data profiling 120, 121, 201, 204, 205, 206, 207
statistics 121
data profiling in synonyms 120, 201
data security 186, 190, 191, 194
Data Servers folder 21
data source
  interpretation 17
data source descriptions 13
data source interpretation 14
data sources 13, 186, 190, 191
data type terminology 14
DBA (database administration) 186
DBA Pane 189
decrypting Master Files 194
DEFINE field for OCCURS 168
definition 14
deleting a field from group fields 183
deleting dimensions 138
deleting dimensions or parent/child hierarchies 145
deleting group field from segment 183
deleting measures 145
deleting passwords 194
describing data sources 13
Developer Studio
  options not supported in Web Console 17
Developer Studio Business Views 148
Developer Studio Create Synonym tool 15

Dimension Builder 136
Dimension Builder toolbar 139

E
edaserve.cfg server file 39
edasprof.prf server file 39
editing field names and titles 142
editing Master Files 138
editing titles for multiple languages 143
encrypting Master Files 194

F
field values 191
Field View tab 72, 92
fields 198
file attributes summary 99
file descriptions 13, 14
Filter calculator 176
filters 161
FOCUS data sources 209, 210, 212
  creating 209
  rebuilding 210

G
group field attributes 184

H
header names 66
identifying procedures in fields 198
identifying procedures in Master Files 198
Impact Analysis 198
Impact Analysis tool 197
indexes
rebuilding 212
indexing fields 212

leaf nodes 142
library 56

Manage Adapters 34
Master Files 14, 19, 96, 97, 135, 138, 186, 194, 197, 198, 213
checking the integrity 213
creating synonyms 19
identifying procedures within 197
new 135
Master Files in Business View 155
Microsoft SQL Server 60
Modeling View tab 95, 110, 136
multilingual titles and descriptions in Synonym Editor 106

nodes 62, 63, 69
adding nodes to files 63
changing a remote server node 69
classes 63

OCCURS repetitions in a DEFINE field 168
odin.cfg file 62
OLAP 136
OLAP dimensions 137
outliers 121, 207
parameters 63
passwords 186, 194
pattern columns 121, 204
printing Master Files 96, 97
profiles for specified servers in nodes 69
read access to data sources 190
read/write access to data sources 190
Rebuild dialog box 210, 213
Rebuild tool 210
Rebuild utility 210
rebuilding FOCUS data sources 210
remote servers 19, 25, 40, 45, 62, 63, 69
adding in Developer Studio 40
adding to server configuration 25
and the WebFOCUS Client 62
configuring 62
configuring in Developer Studio 19
reorganizing FOCUS data sources 212
reporting against Sybase ASE stored procedure 54
Reporting Server Console 17, 24, 61
restrict object type to 56

Describing Data With Graphical Tools 217
restricting access to data 190, 191
restricting access to data sources 191
restricting access to field values 191

S

securing data 186, 190, 191, 194
securing data in Master Files 186
security 194
security in data sources 186
segment attributes summary 101
Segment View tab 94
Server Console 61, 62
  accessing 62
  creating synonyms 62
single column 121, 205, 206, 207
Snowflake 130
statistics 205
stored procedures 54, 60
synonym
  definition 14
  enhancing 16
  uses 16
synonym attributes 97
synonym attributes in Synonym Editor 97
Synonym Editor 71, 72, 74, 92, 94, 95, 96, 97, 128, 135, 197
  cluster joins 135
  layout 72
Synonym Editor toolbar 74
synonyms 19, 28, 46, 50, 54, 56, 60, 61, 62, 71, 110, 201
  creating 28, 46, 62
  creating in Developer Studio 46
  creation in Microsoft SQL Server 50
  creation parameters 56
synonyms (continued)
  creation parameters for stored procedures 54
deleting 61
  for Microsoft SQL Server stored procedure
  CustOrders 60
  refreshing 60

T
temporary fields 166
testing connections to remote servers 45
Text View tab 96

V
validating Master Files 213
value columns 121
values for data profile 206
viewing and editing synonym attributes 97
Virtual Column calculator 176
virtual field attributes 172
virtual field for OCCURS 168
virtual fields 166

W
Web Console 61
WebFOCUS Administration Console 62, 63
WebFOCUS Client 62
WebFOCUS Environments 21
WebFOCUS Environments and remote servers 62
WebFOCUS Reporting Servers
  configuring 61
write access to data sources 190
Customer Connections

Where users partner with Information Builders to provide feedback and create quality documentation.

Partner With Us

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also join a usability study to get an early look at new documentation products and services. Your participation helps us create documentation products that meet your needs.

To send us feedback or make a customer connection, contact Michele Brady, Service Director, Technical Content Management at Michele_Brady@ibi.com.

Request Permission to Use Copyright Material

To request permission to repurpose copyrighted material, please contact Frances Gambino, Executive Director, Technical Content Management at Frances_Gambino@ibi.com.

Visit the Information Builders Technical Documentation Library

To visit the Technical Documentation Library, go to http://documentation.informationbuilders.com/.